
To start Word 2013: 

Click on the Start button, select All Programs, select Microsoft Office, and 

then select Microsoft Word 2013 from the menu options.  

 

Window and Ribbon Features: 
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FILE TAB 
   The File tab provides you with the Backstage that provides information 

pertaining to your document and options to help setup your window defaults. The 

Backstage also contains standard commands such as, Save, Save As, New, Print, etc.

 

1. New – create a new file or folder. 

2. Open – open a particular file or folder. ... 

3. Save: save the file. 

4. Save As: enabled to save the file with changes in the name of another file. 

o Click on the File tab, then select the Save As option to save a 
document permanently to your hard drive or other storage device. 
(The instructor will demonstrate where to save document.)  

o The Save As window will appear. 
o In the Directory sections on the left side of the window, click on the 

icon where you wish to save your document. In this exercise click on 
the Desktop.  

o In the File Name box, type your desired document name, and then 
click on the Save button. 

5. Print: used to give print command. 

6. Exit: used to close the application and exit. 

7. Templates : 



Microsoft Office has a variety of predesigned templates within specific 
categories. 
            Open Templates 

1. Select the File tab, and then click on the New option.  
2. The Available Templates window will appear. 

 

 
 

8. Window Options:  

  The Microsoft Word application allows you to customize setting and 
preferences as you work within your Word document.  

  Set options  

1. Click on the File tab, and then select the Options item.  

2. The Word Options window will appear. This is where you can choose your 
desired settings and preferences. 



 
 

A) Customize Your Ribbon:  
You can easily customize the Ribbon to suit your needs by creating new 
tabs and filling them with the commands you use the most.  

Customize Ribbon commands  

1. Click on the File tab, and then select the Options Item.  

2. The Word Options window will appear. 
3. Click on the Customize Ribbon option.  



 
4. From the Choose commands from list, click on your desired ribbon 
option, and then click on the Add button to place it in the Customize the 
Ribbon list.  

5. Click on the OK button. 

B) Quick Access Toolbar: 

   Microsoft Word 2013 has a Quick Access Toolbar, so you can 
have quick access to your most used commands.  

Add Commands  

1. To add your most used commands to the Quick Access Toolbar, click on 
the drop-down arrow next to the Quick Access Toolbar.  

2. The Customize Quick Access Toolbar option panel will appear.  

 



 

1. Click on your desired command option to be placed on the Quick Access 
Toolbar. 

 

 

 

 

 

HOME TAB 
 

A. Clipboard 

You can quickly display the Clipboard task pane by clicking on the dialog 
launcher in the bottom right corner of this group. 

  
 Paste - Button with Drop-Down. The drop-down contains the commands: 

Paste, Paste Special and Paste as Hyperlink. 

 Cut - (Ctrl + X). Cuts the current selection to the clipboard. 

 Copy - (Ctrl + C). Copies the current selection to the clipboard. 

 Format Painter - (Ctrl + Shift + C). Copies the formatting from one place in a 
document and lets you apply it somewhere else. This works across multiple 
documents. 

 

B. Font 
This group provides access to all the Character Formatting commands. 
You can quickly display the "Font" dialog box, Font Tab, by clicking on the 
dialog box launcher in the bottom right corner of this group. 

 
 Font - (Ctrl + Shift + F). Provides a list of all the available fonts (based on your 

current printer selection). 
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 Font Size - (Ctrl + Shift + P). Let’s you adjust the character size (based on your 
current printer selection). 

 Grow Font - (Ctr + >). Increases the font size of the current selection to the 
next larger size in the Font Size box. This was called Increase Font in Word. 

 Shrink Font - (Ctrl + <). Decreases the font size of the current selection to the 
next smaller size in the Font Size box. This was called Decrease Font in Word. 

 Change Case - Drop-Down. Changes the selected text to either uppercase, 
lowercase or another type of capitalisation. The drop-down contains the 
commands: Sentence Case, Lowercase, Uppercase, Capitalize Each Word and 
Toggle Case. 

 Clear All Formatting - (Ctrl + Spacebar). Clears all the formatting from the 
current selection. 

 Bold - (Ctrl + B). Toggles bold on the current selection 

 Italic - (Ctrl + I). Toggles italics on the current selection. 

 Underline - (Ctrl + U). Button with Drop-Down. The button toggles bold on 
the current selection. The drop-down contains the commands: Underline, 
Double Underline, Thick Underline, Dotted Underline, Dashed Underline. 

 Strikethrough - Draws a line through the middle of the selected text. 

 Subscript - (Ctrl + =). Converts the selection to small letters below the text 
baseline. 

 Superscript - (Ctrl + Shift + +). Converts the selection to small letters above 
the text baseline. 

 Text Effects and Typography – You can add shadows, bevels, reflections, and 
much more. The Text Effects button is in the Font group of the ribbon. The 
top options in the Text Effects menu have some pre-created styles to choose 
from. The Text Effects menu also has the options Outline, Shadow, 
Reflection, and Glow. 

 Text Highlight Color - Button with Drop-Down. Shades the background 
behind the current selection. The drop-down contains the commands: No 
Color and Stop Highlighting. For more details please refer to the Characters > 
Text Highlight page. 

 Font Color - Button with Drop-Down. The button changes the colour of the 
font of the current selection. The drop-down contains the commands: 
Automatic, Theme Colors, Standard Colors and More Colors. 
 

C. Paragraph 

This group provides access to all the Paragraph Formatting commands. 
You can quickly display the "Paragraph" dialog box, Indents and Spacing Tab, 
by clicking on the dialog box launcher in the bottom right corner of this 
group. 
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 Bullets - Button with Drop-Down. The button toggles single level bullets from 

the selected paragraphs. The drop-down contains the commands: Recently 
Used Bullets, Bullet Library, Document Bullets, Change List Level and Define 
New Bullet. The Change List Level extension displays levels 1 to 9. The Define 
New Bullet displays the "Define New Bullet" dialog box. 

 Numbering - Button with Drop-Down. The button toggles single level 
numbering from the selected paragraphs. The drop-down contains the 
commands: Recently Used Numbering, Change List Level, Define New 
Number Format and Set Numbering Value. 

 Multilevel List - Drop-Down. The drop-down contains the commands: 
Current List. List Library, Change List Level, Define New Multilevel List and 
Define New List Style. A multilevel list shows the list of items at different 
levels, rather than just at one level. This was previously accessible from the 
Outline Numbered tab on the Bullets & Numbering dialog box and has 
replaced Outline numbering. Please refer to the Bullets > Multilevel List for 
more details. 

 Decrease Indent - Decreases the indent by 1 or removes the indent 
completely. 

 Increase Indent - Increases the indent by 1. 

 Sort - Displays the "Sort Text" or "Sort" dialog boxes allowing you to sort 
paragraphs of text or text within tables. If your current selection is not in a 
table then the "Sort Text" dialog box is displayed. If the current selection is in 
a Table then the "Sort" dialog box is displayed. This command was previously 
on the Table drop-down in 2013 but now appears both on the Home Tab and 
Table Tools - Layout contextual tab. 

 Show/Hide Paragraph Marks - (Ctrl + *). Toggles the display of paragraph 
marks and other hidden formatting. 

 Align Left - (Ctrl + L). Aligns text to the left. 

 Center - (Ctrl + E). Aligns text to the center. 

 Align Right - (Ctrl + R). Aligns text to the right. 

 Justify - (Ctrl + J). Aligns text to both left and right margins adding extra 
space between words where necessary. 

 Line Spacing - Drop-Down. The drop-down contains the commands: 1.0, 
1.15, 1.5, 2.0, 2.5, 3.0, Line Spacing Options, Add Space before Paragraph 
and Add Space after Paragraph. The Line Spacing Options command displays 
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the "Paragraphs" dialog box (Indents and Spacing tab). The default line 
spacing is 1.15. 

 Shading - Button with Drop-Down. The button applies the selected shading 
to the current selection. The drop-down contains the commands: Theme 
Colors, Standard Colors, No Color and More Colors. 

 Border - Button with Drop-Down. The button applies the selected border to 
the current selection. The drop-down contains the commands: Bottom 
Border, Top Border, Left Border, Right Border, No Border, All Borders, 
Outside Borders, Inside Borders, Inside Horizontal Border, Inside Vertical 
Border, Diagonal Down Border, Diagonal Up Border, Horizontal Line, Draw 
Table, View Gridlines and Borders and Shading. 
 

D. Styles 
You can quickly toggle the display of the Styles Task Pane by clicking on the 
dialog box launcher in the bottom right corner of this group. 

 
 Quick Styles - Displays a gallery of available styles (with auto preview). Is the 

Heading 1 style different in 2007 and 2010 to 2013. Yes the Normal template 
and styles are very different. 

 Create a style -Styles are format settings that you apply to multiple sections 
of text. For example, you can apply Heading 1 style to all your top level 
headings, and Heading 2 style to all subheadings at the next level 
 

E. Editing 
 

 Find - Button with Drop-Down. The button displays the 
"Find and Replace" dialog box and displays the Find tab. 
The drop-down contains the commands: Find and 
GoTo. The GoTo tab can also be displayed by clicking on 
the Page: 1 of 2 indicator on the status bar in the 
bottom left corner. 

 Replace - This displays the "Find and Replace" dialog box and displays the 
Replace tab. 

 Select - Drop-Down. The drop-down contains the commands: Select All, 
Select Objects and Select Text with similar Formatting. The Select Text will 
select text with similar formatting. 
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INSERT TAB 
       This tab contains all the commands for inserting items into your documents. 
 

1. Pages 

 

 

 Cover Page - Drop-Down. The drop-down contains the commands: Built-in, 
Remove Current Cover Page and Save Selection to Cover Page Gallery. The 
list of built-in cover pages is Alphabet, Annual, Austere, Conservative, 
Contrast, Cubicles, Exposure, Mod, Motion, Pinstripes, Puzzle, Side-line, 
Stacks, Tiles and Transcend. 

 Blank Page - Inserts a blank page by inserting two page breaks, one above 
the current insertion point and one below it. 

 Page Break - (Ctrl + Enter). Inserts a page break instead of displaying the 
Breaks dialog box. You can access all the other types of breaks using the 
Breaks drop-down on the Page Layout tab, Page Setup group. 

 

2. Tables 
When a table is selected you will see additional contextual tabs Tables > 
Table Tools Design 

 
 Table - Drop-Down. This lets you quickly drag out the table size. The 

maximum size you can drag is (10 by 8). The drop-down contains the 
commands: Insert Table, Draw Table, Convert Text to Table, Excel 
Spreadsheet and Quick Tables. The Insert Table displays the "Insert Table" 
dialog box. The Draw Table lets you create a table by inserting horizontal and 
vertical lines using the mouse. The Convert Text to Table displays the 
"Convert Text to Table" dialog box. The Excel Spreadsheet command inserts 
an Excel worksheet into the document. The Quick Tables lets you insert 
tables that have been stored as building blocks. 
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3. Illustrations 

 

 Pictures - Displays the "Insert Picture" dialog box. 

 Online Pictures - Find and insert pictures from online resources. 

 Shapes - Drop-Down. The drop-down contains the commands: Recently Used 
Shapes, Lines, Rectangles, Basic Shapes, Block Arrows, Flowchart, Callouts 
and Stars and Banners. This list is slightly different in Excel. 

 SmartArt - Displays the "Choose a SmartArt Graphic" dialog box which lets 
you choose from the following different types of smartart: list, process, 
cycle, hierarchy, relationship, matrix and pyramid. 

 Chart - Displays the "Insert Chart" dialog box. There is no more MS Graph 
and datasheet. Chart data is now opened up in an Excel spreadsheet. 

 Screenshot - The drop-down contains the commands: Available ScreenShots 
and Screen Clipping. 
 

4. Apps for Office  
Insert an App into your document to introduce additional 
functionality.   

  

5. Media 
 Online Video - Find and insert videos from online resources.  

  

6. Links 

 Hyperlink - (Ctrl + K). Create a link in your 
document for quick access to webpages and 
other files. Displays the "Insert Hyperlink" 
dialog box. 

 Bookmark - This displays the "Bookmark" dialog box. 

 Cross-Reference - Displays the "Cross Reference" dialog box. This lets you 
cross reference other parts of your document. Typically used for figure 
numbers and section heading 



7. Comments 
 Comment - Insert a comment into this part of the document. 

 
 
 

8. Header & Footer 
 Header - Drop-Down. This displays a gallery of the built-in headers. The drop-

down also contains the commands Edit Header, Remove Header and Save 
Selection to Header Gallery. Also appears on the Header and Footer Tools - 
Design contextual tab. 

 Footer - Drop-Down. This displays the gallery of 
built-in footers. The drop- down also contains the 
commands Edit Footer, Remove Footer and 
Save Selection to Footer Gallery. Also appears 
on the Header and Footer Tools - Design 
contextual tab. 

 Page Number - Drop-Down. The drop-down contains the commands: Top of 
Page, Bottom of Page, Page Margins, Current Position, Format Page 
Numbers and Remove Page Numbers. The first four commands all display 
galleries of built-in page number options and allow you save your own to the 
gallery. The Format Page Numbers command displays the familiar "Page 
Number Format" dialog box. Also appears on the Header and Footer Tools - 
Design contextual tab. Why/When is this disabled? 

 

 

 

9. Text 
 Text Box - Drop-Down. Let’s you insert a textbox that can be positioned 

anywhere on the page. The 
drop-down contains the 
commands: Built-in, Draw 
Text Box and Save 
Selection to Text Box Gallery. 
There are 36 different types of built-in textbox shapes and positions. 

 Quick Parts - Drop-Down. The drop-down contains the commands: AutoText 
(Added in 2010), Document Property, Field, Building Blocks Organizer, Get 
More on Office Online (Removed in 2010) and Save Selection to Quick Part 
Gallery. 



 WordArt - Drop-Down. The drop-down gives you a choice of Word Art styles 
to insert. The "Edit WordArt Text" dialog box is displayed when you click on a 
word art style. The styles are slightly different to those in Excel. 

 Drop Cap - Drop-Down. The drop-down contains the commands: None, 
Dropped, In Margin and Drop Cap Options. The Drop Cap Options command 
displays the "Drop Cap" dialog box. 

 Signature Line - Button with Drop-Down. Let’s you use and insert digital 
signatures into your documents. The button inserts a digital signature line 
that specifies the individual who must sign. The drop-down contains the 
commands: Microsoft Office Signature Line and Add Signature Service. 

 Date & Time - Displays the "Date and Time" dialog box. 

 Object - Button with Drop-Down. The button displays the "Object" dialog box 
allowing you to insert embedded objects. The drop-down contains 
commands: Object and Text from File. 

 

 

 

10. Symbols 

 

 
 

 Equation - Button with Drop-Down. The button inserts an equation at the 
current location and then displays the Equation Tools - Design Tab. The drop-
down contains the following built-in equations: Area of Circle, Binomial 
Theorem, Expansion of a Sum, Fourier series, Pythagorean Theorem, 
Quadratic Formula. At the bottom are the commands: Insert New Equation 
and Save Selection to Equation Gallery. 

 Symbol - Drop-Down. Let’s you insert symbols into your documents. The 
drop-down contains the commands: Euro, Pound, Yen, Copyright, 
Registered, Trademark, Plus-Minus, Not Equal To, Less-Than or Equal To, 
Greater-Than or Equal To, Division, Multiplication, Infinity, Micro, Alpha, 
Beta, Pi, Ohm, Summation, Smiley Face and More Symbols. The More 
Symbols command display the "Symbol" dialog box. Different to Excel it 
displays the common symbols for quick insertion. 
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DESIGN TAB 
 

 

1. Document Formatting 

 

 
 

 Themes - (Moved in 2013). Drop-Down. The drop-down contains the 
commands: Built-in, More Themes on Microsoft Office Online, Browse for 
Themes and Save Current Theme. The built-in themes are: Office, Apex, Aspect, 
Civic, Concourse, Equity, Flow, Foundry, Median, Metro, Module, Opulent, 
Oriel, Origin, Paper, Solstice, Technic, Trek, Urban and Verve. Tooltip indicates 
the current theme. The default theme is "Office". Tooltip indicates the current 
theme. Quick Access to more themes saved down on Microsoft Office Online. 
Default theme is "Office". Changes the overall design of the entire document in 
colours, fonts and effects. This drop-down has an additional command not 
found in Excel or PowerPoint which is "Reset to Theme from Template". 

 Style Set - (Added in 2013). Change the look of your document by choosing a 
new style set. Style sets change the font and paragraph properties of your 
entire document. 

 Colors - (Moved in 2013). Drop-Down. Displays a list of all the available colors 
and lets you change the color component of the active theme. 

 Fonts - (Moved in 2013). Drop-Down. Displays a list of all the available fonts 
and lets you change the font component of the active theme. 

 Paragraph Spacing - (Added in 2013). Drop-Down. Quickly change the line and 
paragraph spacing in your document. The drop-down contains the commands: 
No Paragraph Space, Compact, Tight, Open, Relaxed, Double, Custom 
Paragraph Spacing. 

 Effects - (Moved in 2013). Drop-Down. Displays a list of all the available effects 
and lets you change the effect component of the active theme. The drop-down 
contains the commands: Office, Apex, Aspect, Civic, Concourse, Equity, Flow, 
Foundry, Median, Metro, Module, Opulent, Oriel, Origin, Paper, Solstice, 
Technic, Trek, Urban and Verve. 

 Set As Default - (Added in 2013). Use the current look for all new documents. 



2. Page Background 

 

 
 

 Watermark - Drop-Down. The drop-down contains the commands: Custom 
Watermark, Remove Watermark and Save Selection to Watermark Gallery. 

 Page Color - Drop-Down. Let’s you change the background colour of the 
page. Displays the full theme colour palette. 

 Page Borders - Displays the "Border and Shading" dialog box. 
 
 
 
 

 PAGE LAYOUT TAB 
This tab provides quick access to Page Setup options as well as additional       

paragraph indent and spacing options. 

 
1. Page Setup 

You can display the "Page Setup" dialog box, Margins Tab, by clicking on the 
dialog box launcher in the bottom right corner of this group. 

 

 Margins - Drop-Down. Let’s you choose from one of the built-in margin 
settings or lets you customise your own. Similar to Excel but has 2 more 
options "Moderate" and "Mirrored". Custom Margins displays the "Page 
Setup" dialog box (Margins tab). 



 Orientation - Drop-Down. Let’s you change the orientation of the current 
section. The drop-down contains the commands: Portrait and Landscape. 
This provides a shortcut to the (Page Setup) (Page tab, Orientation). 

 Size - Drop-Down. Let’s you select from all the different available paper sizes. 
This provides a shortcut to the (Page Setup) (Page tab, Paper size drop-
down). 

 Columns - Drop-Down. The drop-down contains the commands: One, Two, 
Three, Left and Right and the command More Columns. Provides access to 1, 
2, 3 column layouts. 

 Breaks - Drop-Down. The drop-down contains the commands: Insert Page 
Break, Remove Page Break and Reset All Page Breaks. 

 Line Numbers - Drop-Down. The drop-down contains the commands: None, 
Continuous, Restart Each Page, Restart Each Section, Suppress for Current 
Paragraph and Line Numbering Options. The Line Numbering Options 
displays the "Page Setup" dialog box (Layout tab). 

 Hyphenation - Drop-Down. The drop-down contains the commands: None, 
Automatic, Manual and Hyphenation Options. The Hyphenation Options 
displays the "Hyphenation" dialog box. 

 

2. Paragraph 

You can quickly display the "Paragraph" dialog box, Indents and Spacing tab, 
by clicking on the launcher in the bottom right corner of this group. 
These are options taken from the (Format Paragraph) (Indents and Spacing 
tab) for quick access. 

 

 Indent Left - Textbox. This automatically updates to indicate how much 
indentation has been applied to the paragraph of the current selection. This 
can be used to change the left indentation for the current selection. 

 Indent Right - Textbox. This automatically updates to indicate how much 
indentation has been applied to the paragraph of the current selection. This 
can be used to change the right indentation for the current selection. 
Spacing Before - Textbox. This automatically updates to indicate how much 



spacing is defined before the paragraph of the current selection. This can be 
used to change the spacing for the current selection. 

 Spacing After - Textbox. The automatically updates to indicate how much 
spacing is defined after the paragraph of the current selection. This can be 
used to change the spacing for the current selection. 

 

3. Arrange 

This group also appears on the Drawing Tools - Format contextual tab. 

 

 Position - Drop-Down. Displays a list of picture positioning options. The drop-
down contains the commands: In Line With Text and Text Wrapping. You can 
select More Layout Options to display the "Advanced Layout" dialog box. 

 Wrap Text - (Text Wrapping in 2007). Drop-Down. The drop-down contains 
the commands: In Line with Text, Square, Tight, Through, Top and Bottom, 
Behind Text, In Front of Text, Edit Wrap Points and More Layout Options. 

 Bring Forward - (Bring to Front in 2007). Button with Drop-Down. The button 
brings the selected object forward one level. The drop-down provides a 
command to bring the selected object in front of all the other objects. 

 Send Backward - (Send to Back in 2007). Button with Drop-Down. The button 
brings the selected object back one level. The drop-down provides a 
command to send the selected object to the back of all the other objects. 

 Selection Pane - (Added in 2010). Displays the Selection Pane task pane. 
 Align - Drop-Down. The drop-down contains the commands: Align Left, Align 

Center, Align Right, Align Top, Align Middle, Align Bottom, Distribute 
Horizontally, Distribute Vertically, Align to Page, Align to Margin, Align 
Selected Objects, View Gridlines and Grid Settings. The Grid Settings displays 
the "Drawing Grid" dialog box. 

 Group - Drop-Down. The drop-down contains the commands: Group, 
Regroup and Ungroup. 

 Rotate - Drop-Down. The drop-down contains the commands: Rotate Right 
90, Rotate Left 90, Flip Vertical, Flip Horizontal and More Rotation Options. 



REFERENCES TAB 

This tab gives you access to all the commands for creating references within 
your documents. 

 

1. Table of Contents 

 

 
 

 

 Table of Contents - Drop-Down. Provide an overview of your document by 
adding a table of contents. The drop-down contains the commands: Built-in, 
Insert Table of Contents and Save Selection to Table of Contents Gallery. 

 Add Text - Drop-Down. The drop-down contains the commands: Do Not 
Show in Table of Contents, Level 1, Level 2 and Level 3. 

 Update Table - Updates the table of contents so that all the entries refer to 
the correct page numbers. 
 

2. Footnotes 

You can quickly display the "Footnote and Endnote" dialog box by clicking 
on the dialog box launcher in the bottom right corner of this group. 

 

 Insert Footnote - (Alt + Ctrl + F). Inserts a footnote at the current position. 
Footnotes are automatically renumbered as you move text around the 
document. 



 Insert Endnote - (Alt + Ctrl + D). Inserts an endnote at the end of the 
document. End notes are always placed at the end of a document. 

 Next Footnote - Button with Drop-Down. The button moves to the next 
footnote. The drop-down provides the commands Next Footnote, Previous 
Footnote, Next Endnote and Previous Endnote. 

 Show Notes - Shows where footnotes and endnotes are located. 

 

 

3. Citations & Bibliography 

In 2003 the Mark Citation dialog box was found on the Table of Authorities 
dialog box? 

 

 Insert Citation - Drop-Down. The drop-down contains the commands: Add 
New Source, Add New Placeholder and Search Libraries. 

 Manage Sources - Displays a list of all the sources cited in the active 
document. 

 Style - Choose the style of citation to use in the document. 

 Bibliography - Drop-Down. The drop-down contains the commands: Insert 
Bibliography and Save Selection to Bibliography Gallery. 

4. Captions 

 

 Insert Caption - Insert a caption below a picture or graphic to provide a short 
description. 

 Insert Table of Figures - Add a list of captioned objects and their page 
numbers. 



 Update Table - Updates the table of figures to include all of the entries in the 
document. 

 Cross-reference - Displays the "Cross-reference" dialog box allowing you to 
insert cross-referencing into your document, for example: turn to page 3 or 
please refer to page 12. Cross references are inserted as hyperlinks. 

 

 

1. Index 

 

 

 Mark Entry - (Alt + Shift + X). Marks the currently selected text so it will 
appear in the index of the document. 

 Insert Index - Add an index listing key words and page numbers they appear 
on. 

 Update Index - Updates the index table. 

 

 

6. Table of Authorities 

 

 Mark Citation - (Alt + Shift + I). Adds the currently selected text so it will 
appear in the table of authority. 

 Insert Table of Authorities - Inserts a table of authorities for cases, statutes 
and other authorities in the document. 

 Update Table - Updates the table of authorities to include all the citations in 
the document. 



MAILINGS TAB 
This tab contains everything needed to complete a successful mail merge 

 

1. Create 

 

 Envelopes - Lets you create and print envelopes. 

 Labels - Lets you create and print labels. 

 

2. Start Mail Merge 

 

 Start Mail Merge - Drop-Down. The drop-down contains the commands: 
Letters, E-mail Messages, Envelopes, Labels, Directory, Normal Word 
Document and Step-by-Step Mail Merge Wizard. Creates a form letter which 
you intend to email or print multiple times sending each copy to a different 
recipient. Displays the "New Address List" dialog box. 

 Select Recipients - Drop-Down. The 3 options are from step 3 of the wizard. 
The drop-down contains the commands: Type New List, Use Existing List and 
Select from Outlook Contacts. Type New List displays the "New Address List" 
dialog box. You will have to save this list as a Microsoft Office Address List 
(.mdb). 

 Edit Recipient List - Displays the "Mail Merge Recipients" dialog box allowing 
you to change or filter the list of recipients. 

 

 



3. Write & Insert Fields 
These commands are only available when you are in a mail merge 
document. 

 
 

 Highlight Merge Fields - Highlights all the fields in the active document that 
have been inserted. This makes is easy to see what will be replaced. 

 Address Block - Displays the "Insert Address Block" dialog box. This allows 
you to customise how the address will be inserted. 

 Greeting Line - Displays the "Insert Greeting Line" dialog box. Let’s you add a 
greeting line to your document. 

 Insert Merge Field - Button with Drop-Down. The button displays the "Insert 
Merge Field" dialog box. The drop-down allows you to quickly insert a merge 
field just by clicking on it in the list and contains the commands: Title, First 
Name, Last-named, Company Name, Address_Line_a, Address_Line_2, City, 
State, Zip Code, Country_or_Region, Home_Phone, Work Phone, Email 
Address. 

 Rules - Drop-Down. Let’s you add decision making rules to the mail merge. 
The drop-down contains the commands: Ask, Fill-in, If-Then-Else, Merge 
Record, Merge Sequence, Next Record, Next Record If, Set Bookmark, Skip 
Record If. 

 Match Fields - Displays the "Match Fields" dialog box allowing you to match 
the required fields with the recipients list. 

 Update Labels - Only enabled when creating labels. Updates all the labels in 
the document to be consistent with the first label. 

 

 

4. Preview Results 

 



 Preview Results - This is disabled when there are no fields in your document. 
Toggles the merged fields in your document with actual data from your 
recipient list. 

 First Record - View the first record in the recipient list. 

 Previous Record - View the previous record in the recipient list. 

 Go to Record - View a specific record in the recipient list. 

 Next Record - View the next record in the recipient list. 

 Last Record - View the last record in the recipient list. 

 Find Recipient - Displays the "Find Entry" dialog box to search for a particular 
text entry. 

 Auto Check for Errors - (Alt + Shift + K). Displays the "Checking and Reporting 
Errors" dialog box. This allows you to simulate the mail merge and to specify 
how to handle any errors that occur during mail merge. You can even 
simulate the merge and report errors in a new document. 

 

 

5. Finish 
 
 
 
 
 

 Finish & Merge - Drop-Down. The drop-down contains the commands: Edit 
Individual Documents, Print Documents and Send E-mail Messages. 

 

 

 

 

REVIEW TAB 
This tab provides commands previously found on the Reviewing toolbar, 
Comments toolbar, Protection toolbar and Tools menu. 

 

 



1. Proofing 

 

 Spelling & Grammar - Displays the "Spelling and Grammar" dialog box. This 
allows you to check the spelling and grammar in the active document. 

 Research - Toggles the display of the Research task pane. Same as Excel. 

 Thesaurus - Toggles the display of the Research task pane defaulting the 
research service to the thesaurus. Same as Excel. 

 Word Count - This displays the "Word Count" dialog box displaying the 
document statistics. This replaces the Word Count Toolbar. This dialog box 
can also be displayed by clicking on the word count indicator on the status 
bar. 

2. Language 

 

 

 Translate - Drop-Down. Displays the Research task pane. This drop-down 
contains the commands: Translate Document, Translate Selected Text, 
Mini Translator and Choose Translation Language. 

 Language - Drop-Down. This drop-down contains the commands: Set 
Proofing Language and Language Preferences. Set Proofing Language 
display the "Language" dialog box. Language Preferences displays the 
"Options" dialog box, Language Tab. 

 

 

3. Comments 



 

 New Comment - (Shift + F2). Inserts a comment at the active cell. This 
command does not change to Edit Comment when a comment is selected 
like it does in Excel. 

 Delete - Button with Drop-Down. Deletes the selected comment. The button 
deletes the comment in the active selection. The drop-down contains the 
commands: Delete All Comments Shown and Delete all comments in 
Document. This is disabled when the document does not contain any 
comments. 

 Previous - Goes to the previous comment in the active document. This is 
disabled when the document does not contain any comments. 

 Next - Goes to the next comment in the active document. This is disabled 
when the document does not contain any comments. 

 Show Comments - To view all comments, no matter which document view is 
chosen, summon the Reviewing pane: Click the Review tab, and in the 
Tracking group, click the Reviewing Pane button. Choose either the 
horizontal or vertical display to summon the Reviewing pane and 
peruse comments as well as text revisions. 

 

 

4. Tracking 

 

 Track Changes - (Ctrl + Shift + E). Button with Drop-Down. The button is the 
Track Changes command from the Reviewing toolbar that? The drop-down is 
the old (Show > Options) from the Reviewing toolbar and contains the 
commands Track Changes, Change Tracking Options and Change User Name. 
Change Tracking Options displays the Track Changes Options dialog box. 
Change User Name displays the Word Options dialog box (Popular tab). 



 Display for Review - Drop-Down. The drop-down contains the commands: 
Simple Markup (previously Final Showing Markup), All Markup (previously 
Showing Markup), No Markup (previously Final) and Original. 

 Show Markup - Drop-Down. The drop-down contains the commands: 
Comments, Ink, Insertions and Deletions, Formatting, Markup Area Highlight 
(removed in Specific People (previously Balloons (Highlight Updates Other 
Authors  
 Balloons - Drop-Down. Let’s you choose how to display the revisions 

either in the margin or in the actual document. The drop-down contains 
the commands: Show Revisions in Balloons, Show all Revisions Inline and 
Show Only Comments and Formatting in Balloons. 

 Reviewing Pane - Button with Drop-Down. The button toggles the display of 
the Reviewing pane. The drop-down contains the commands: Reviewing 
Pane Vertical and Reviewing Pane Horizontally. There is now also summary 
information at the top of the pane. 

 

 

5. Changes 

 

 Accept - Button with Drop-Down. The button is the Accept and Move to Next 
command which accepts the current change and moves to the next proposed 
change. The drop-down contains the commands: Accept and Move to Next, 
Accept Change, Accept all Changes Shown and Accept all Changes in Document. 
This drop-down is disabled when the document is protected. 

 Reject - Button with Drop-Down. The button is the Reject and Move to Next 
command which rejects the current change and moves to the next proposed 
change. The drop-down contains the commands: Reject and Move to Next, 
Reject Change, Reject all Changes Shown and Reject all Changes in Document. 
This drop-down is disabled when the document is protected. 

 Previous - Moves to the previous revision in the active document. This is a bit 
confusing as it does exactly the same as the Previous in the comments group? 

 Next - Moves to the next revision in the active document. 



 

 

6. Compare 

 

 Compare - Drop-Down. The drop-down contains the commands: Compare and 
Combine. The Compare command lets you compare two versions of the same 
document and displays the "Compare Documents" dialog box. The Combine 
command lets you combine revisions from multiple authors and displays the 
"Combine Documents" dialog box. This drop-down is disabled when the 
document is protected. 
 

 

 

7. Protect 

 

 Block Authors - Drop-Down. Prevent others from making changes to the 
selected text. 

 Restrict Editing - Toggles the display of the Restrict Editing task pane. This task 
pane was called "Restrict Formatting and Editing" it’s called "Protect 
Document". 
 

 

 



VIEW TAB 
This tab provides commands previously found in the View menu and Window 
menu. 

 

1. Views 
This group contains all the commands relating to the different ways you can 
view your documents. 

 
 Read Mode - In 2010 this was called Full Screen Reading. Maximises the Word 

window on the screen and removals all toolbars etc to allow easy reading. 

 Print Layout - Displays the document as it would appear if printed and is the 
default view. 

 Web Layout - Displays the document as it would appear as a web page. 

 Outline - Displays the document as an outline is displays the Outlining 
contextual tab. 

 Draft - Displays the document in draft mode allowing for quick editing. When 
using this view certain aspects of the document are not visible, for example any 
headers or footers. 

 

2. Show 

 

 Ruler - Toggles the display of the ruler(s). 

 Gridlines - Toggles the display of gridlines. 

 Navigation Pane - Toggles the display of the Navigation task pane. This is a 
combination of the Find, Document Map and Thumbnails. 
 



3. Zoom 
Everything relating to adjusting the display percentage of the active 
document. There is also a new zoom slider in the bottom right corner next 
to the status bar. 

 
 Zoom - Displays the "Zoom" dialog box. This can also be accessed from the 

status bar by clicking on the view percentage. 

 100% - Adjusts the zoom to 100% of its normal size. Let’s you quickly return to 
100%. 

 One Page - Adjust the zoom so an entire page fits in the application window. 

 Two Pages - Adjust the zoom so two entire pages fit in the application window. 

 Page Width - Adjust the zoom so the width of the page is the same as the width 
of the application window. 

 

 

4. Window 
Every document you open in Word can be thought of as a window. It is 
possible to open multiple windows of the same document. 

 
 New Window - Lets you create a new window of the active document. 

 Arrange All - Tile all the open windows side by side on the screen. This will also 
maximises the application / document to a full screen. 

 Split - Splits the current window into two parts. 

 View Side by Side - Displays two documents side by side so they can be easily 
compared. If you have more than two documents open the "Compare Side by 
Side" dialog box is displayed so you can choose which document to display next 
to the active document. Allowing you to scroll multiple windows at the same 
time. 

 Synchronous Scrolling - Toggles the synchronize scrolling of the two documents 
that are displayed side by side. This is only enabled when you are viewing two 
documents side by side. 



 Reset Window Position - Resets the windows positions so they take up the same 
amount of space on the screen when two documents are displayed side by side. 
This is only enabled when you are viewing two documents side by side. 

 Switch Windows - Drop-Down. Let’s you switch between all the currently active 
documents. This displays all the window / documents that are currently open in 
the particular session. Previously these were displayed on the Window menu. 

 

 

6. Macros 

 

 Macros - Button with Drop-Down. The button is the View Macros command and 
displays the "Macros" dialog box. The drop-down contains the commands: View 
Macros, Record Macro and Pause Recording. 
If you want to edit macros or do anything more complicated then you should 
have the Developer tab displayed as well. 

 

 

 

 

 

 
 

 

 

 

 

 



MS EXCEL 
Excel 2013 is a spreadsheet program that allows you to store, organize, and 

analyze information. While you may think that Excel is only used by certain people 

to process complicated data, anyone can learn how to take advantage of Excel's 

powerful features. Whether you're keeping a budget, organizing a training log, or 

creating an invoice, Excel makes it easy to work with different kinds of data.* 

Launching Excel 2013 *** Excel can be started either by selecting the program from the Windows start 

menu, or if there is an existing Excel shortcut available on your computer, it can be double-clicked to 

launch the program . Open Excel by going through these steps : 1. Click the Start button 2. Select All 

Programs 3. Select Microsoft Office 4. Click Microsoft Excel 2013 

 



 

FILE TAB 
ile tab contains the basic required options such as New, Open, Save, Save as, Print, Share, 
Export, and Close options. Other than the aforementioned options, we can find account 
and Excel options tab, too. 

 
  

 
  
a)   Info: - With this option, we can get the information about the particular Excel file. 
Created date, last modified date, Author name, Properties, versions etc. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-119.png
https://www.exceltip.com/wp-content/uploads/2015/07/image-215.png


 
  
b)   New: - We use this option to open the new Excel file. We can open new file using 
shortcut key, Ctrl+N or by Clicking on File tab > New > Blank workbook. If Excel file is not 
opened, then Press Window+R and type Excel, New Excel file will open. 

 
  
c)   Open: - We use this option to open the existing file (shortcut Ctrl+O). “Open” option 
appears and you can choose to open the file. 
Alternatively, File tab > Open > choose the file 

https://www.exceltip.com/wp-content/uploads/2015/07/image-314.png
https://www.exceltip.com/wp-content/uploads/2015/07/image-413.png


 
  
d)   Save: - We use this option to save the current file. 
Shortcut: - Ctrl+S 
Path: - Click on File tab >Save 
e)   Save as: - We use this option to make another copy or save the file at another place. 
F12 is the shortcut key to save as the file or we can save the file following these steps: - 
Click on File tab > Save as and then choose the location. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-55.png


 
  
f)    Print: - We use this option to print  the current file. Ctrl+P is the shortcut key to print, 
or we can follow these steps: - File > Print and then we will have the page setup option. 
We can set the page according to our requirements. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-64.png


 
  
g)   Share: - We use this option to share the file with multiple users and send it over 
email. To share the file we can follow the steps: - Click on File tab >Share. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-74.png


 
  
h)   Export: - We use this option to export the file in PDF or XPS document and we can 
change the file type as well. To Export the file, we can follow the steps: - Click on File tab 
>Export. And then we can export it as per our requirement. 

 
  
i)     Close: - We use this option to close the file. Ctrl+W is the shortcut key to close the 
workbook or we can follow the steps: - Click on File tab >Close, active file will be closed. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-84.png
https://www.exceltip.com/wp-content/uploads/2015/07/image-94.png


When we close the file, we get the confirmation message to save the file or not or cancel 
the command. 

 
  
j)    Account: - We use this option to sign in to our office account and we can change 
office theme, too. We can follow the steps: - Click on File tab >Active, Active window will 
appear. 

 
  
k)   Options: - It was in the tool menu of the previous versions of 2007 MS. We use this 
option to add  extra and advanced features, like Developer tab, Power pivot, Analysis 
toolpak and many more. Also, we can change default settings, like font size, font style, 
number of sheets etc. In Excel options, we have 10 categories:- 
1)    General 
2)    Formulas 
3)    Proofing 
4)    Save 
5)    Language 
6)    Advanced 
7)    Customize Ribbon 
8)    Quick Access toolbar 
9)    Add Ins 
10)  Trust Center 

https://www.exceltip.com/wp-content/uploads/2015/07/image-104.png
https://www.exceltip.com/wp-content/uploads/2015/07/image-118.png


 
  

 

HOME TAB 

The Excel Home Tab is used to perform common commands such as bold, 

underline, copy, and paste. It is also used to apply formats to cells in a worksheet. 

The table below describes the commands in each of the groups in the Home Tab 

1. Clipboard  

Paste To insert data that has been placed on the clipboard into a worksheet cell, 

click this button.  

Cut This button is used to remove data from a worksheet cell and place it on the 

clipboard. Once the data has been placed on the clipboard, it can be inserted into 

another cell in the same worksheet or into a different worksheet.  

https://www.exceltip.com/wp-content/uploads/2015/07/image-124.png


Copy To copy data from a cell in a worksheet so that it can be placed into another 

area of the worksheet, click this button. The data that is copied is placed on the 

clipboard.  

Format Painter Click this button to apply formatting from one cell in a worksheet 

to another cell or range of cells in the same worksheet. Clicking the button once 

will apply the formatting to only one other cell or range. Double-clicking makes it 

possible to apply the formatting to more than one cell or range of cells.  

Clipboard Task Pane Launcher This button is used to open the Clipboard Task 

Pane. It is located in the bottom right corner of the Clipboard Group. The task pane 

shows the items that have been added to the Clipboard. Items can then be pasted 

into the worksheet.  

 

2. Font  

Font Type This button is used to change the style of the font within a cell or a 

range of cells in a worksheet. A list of different font styles will appear. Move the 

mouse pointer over the style to see a Live Preview.  

Font Size To change the size of the font in a cell or range of cells in a worksheet, 

click this button. Move the mouse pointer over each of the sizes to see a Live 

Preview. A list of different font sizes will appear. Click the desired size to select it. 

Increase Font Size This button is used to increase the font size within a cell or 

range of cells. Each time the button is clicked, the size of the font increases by one 

or two points.  

Decrease Font Size Click this button to decrease the size of the font by one or two 

point increments. Each time the button is clicked, the size of the font will decrease 

one or two points.  

Bold To apply bold formatting to a cell or range of cells, click this button.  

Italics To change the style of the font to italics, click this button.  

Underline Click this button to underline the text in a cell or range of cells. Border 

This button is used to apply a border around a cell or a range of cells.  

Fill Color To fill in the background color for a cell or range of cells, click this button.  

Font Color Click this button to change the font for the text in a cell or a range of 

cells.  



Font Settings Dialog Box Launcher To open the Format Cells dialog box with the 

Font Tab selected, click this button. The button is located in the bottom right 

corner of the Font Group.  

3. Alignment 

 

Top Align To vertically align the text in a cell at the top of the cell or range of cells, 

click this button.  

Middle Align This button is used to vertically align the text in the middle of a cell.  

Bottom Align Click this button to vertically align the text at the bottom of the cell.  

Orientation To change the way text is displayed in a cell, click this button. The text 

will rotate in a different direction each time the button is clicked.  

Wrap Text When working with text in a cell, clicking this button will allow long text 

entries to wrap within the cell. When a word won’t fit within the width of the cell, 

it will move to the next line. The height of the cell will expand to accommodate the 

text.  

Align Left To place text or numbers at the left margin of a cell, click this button. 

This is the default for all text items that are placed in a cell.  

Center Click this button to center text or numbers within a cell.  

Align Right This button is used to align text or number entries at the right margin 

of a cell. This is the default for all numbers that are placed in a cell.  

Decrease Indent An indent creates a temporary left margin within a cell. To 

decrease this temporary margin, click this button.  

Increase Indent An indent is used to set a temporary left margin within a cell. It 

usually is set in increments of .5 inches. To increase the temporary left margin, click 

this button. 

Merge and Center To center text across a range of cells, click this button. The 

purpose of this feature is to allow for the placement of a heading across a range of 

columns in a worksheet.  

Alignment Settings Dialog Box Launcher This button is used to open the Format 

Cells dialog box with the Alignment Tab selected. In this dialog box, it is possible to 

make changes to the horizontal and vertical cell alignment, as well as other 



alignment options. The button is located in the bottom right corner of the 

Alignment Group.  

4. Number Group  

Number Format Click the list arrow for this option to display a list of number 

formats. Click the format that is to be applied to the number.  

Accounting Number Format This format will display with a dollar sign and two 

decimal places. To select a different number format, such as the Euro symbol, click 

this button.  

Percent Style To display the value in the cell or range of cells as a percentage, click 

this button.  

Comma Style When this button is clicked, the values in the cell will display with a 

comma separator and two decimal places.  

Increase Decimal To increase the number of decimal places that are displayed for a 

value, click this button.  

Decrease Decimal Click this button to decrease the number of decimal places that 

are displayed for a value. Number  

Format Dialog Box Launcher This button is used to open the Format Cells dialog box with the Numbers 

Tab selected. It can be found in the lower right corner of the Number Group. This dialog box is used to 

make changes to the format of the numbers in the selected cells in the worksheet. 

 

5. Styles Group  

Conditional Formatting This button is used to select different formatting for cells based on particular 

criteria. It is possible to highlight interesting cells, emphasize unusual values, and visualize data using Data 

Bars, Color Scales, and Icon sets.  

Format as Table Click this button to quickly format a selected range of cells as a table using a gallery of 

table styles.  

Cell Styles This button is used to apply predefined formatting to a single cell. A gallery of styles will 

appear. Move the mouse pointer over the style to see a Live Preview of the style.  

6. Cells Group  

Insert To insert cells, sheet rows, or sheet columns, click this button. A list of possible options will appear. 

Click the option that is to be applied to the worksheet.  

Delete This button is used to delete cells, sheet rows, or sheet columns from a worksheet. If the arrow is 

clicked, a list of available options will appear. 



Format Click this button to change the row or column height and width, to organize worksheets in the 

workbook, to protect the document, or to hide a sheet in the workbook. A list of available options will 

appear when the arrow is clicked.  

7. Editing Group  

Auto Sum To display the sum of selected cells directly to the right or below the selection, click this button. 

Where the sum is displayed will depend on whether the selection range is a column or row.  

Fill Click this button to continue a pattern of values in a selected range of cells.  

Clear This button is used to clear the contents from the cells in the selected range. It can also be used to 

clear the formatting or comments associated with the cell selection. S 

ort and Filter To sort the data in a selected range of cells, click this button. It is also possible to filter out 

specific data in the selected cells.  

Find and Select Click this button to locate specific data in a worksheet or a range of cells. It is also possible 

to replace data within the worksheet or range of cells. 

 

 

INSERT TAB 

The Insert Tab is used to insert objects such as charts, pictures, hyperlinks, headers 
and footers, and text boxes. The table below provides a list of the different groups 
and buttons that appear on this ribbon. Groups/Buttons Description  
 

1. Tables Group  
 

Pivot Table This button is used to insert a Pivot Table or Pivot Chart into a current 
worksheet or a new worksheet. Pivot tables are used to summarize and organize 
complicated data.  
Recommended Pivot Tables Click this button to display a customized list of 
PivotTables that will best suit the data in an Excel table.  
Table This button is used to insert a table into the worksheet. Tables make it easy 
to analyse and sort data. 

2. Illustrations Group  

Picture To insert a picture that has been stored on the computer, click this button. 
When the button is clicked, the Insert Picture dialog box will appear. This dialog 
box is used to locate the picture that is to be inserted into the worksheet.  

Online Pictures To insert an image into the worksheet, click this button. Clip art 
images include movies, pictures, and sounds. When the button is clicked the Insert 



Picture window will display. Input the Search criteria and click the Search button. A 
gallery of images will appear.  

Shapes Shapes are objects, such as rectangles, circles, lines, and arrows. To insert a 
shape into the worksheet, click this button. When the button is clicked, a gallery of 
different shapes is displayed.  

Smart Art To insert objects such as organization charts, click this button. A gallery 
of different objects is displayed. This gallery is divided into categories, such as list, 
process, cycle, hierarchy, relationship, matrix, or pyramid.  

Screenshot This feature can be used to insert a picture of any program that is not 
minimized to the taskbar. Click the Screen Clipping link to insert a picture of any 
part of the screen.  

3. Apps Group  

Store Select this option to find apps in the Office Store  

4. Charts Group 

Recommended Charts Select the data in a worksheet and then click this button to 
see a list of customized charts that Excel recommends for the selected data.  

Column or Bar Use this chart type to visually compare values across a few 
categories. 

Hierarchy This chart is used to compare parts to a whole or when several columns 
of categories form a hierarchy.  

Waterfall or Stock To visualize the impact of multiple data points as a running total 
these chart types. They are generally useful for visualizing data over time to see the 
starting points versus the current point and how those points were reached. 

Line or Area These charts are used to show trends for categories or over a period 
of time such as days, months, or years.  

Statistic To show statistical analysis of data, use this type of chart.  

Combo This chart type is used to highlight different types of information. It can be 
used when range of data in the chart varies widely or when a wide range of mixed 
data is used.  

Pie or Doughnut This button is used to insert a pie or doughnut chart into the 
worksheet. These chart types are used to display the contribution of each item to 
the total.  

Scatter or Bubble These chart types are used to compare pairs of values.  

Surface or Radar This type of chart is useful when optimum combinations between 
two sets of data need to be found.  

Pivot Chart in excel is an in-built Programme tool in excel which helps you out to 
summarize selected rows and column of data in a spreadsheet. It's the visual 



representation of a pivot table or any tabular data which helps to summarize & 
analyse the datasets, patterns, and trends. 

Create Chart Dialog Box Launcher to open the Insert Chart dialog box, click this 
button. The purpose of this dialog box is to provide additional chart types that can 
be used in Excel.   

5. Power view group  
Import Data into Excel 2013, and Create a Data Model. Extend Data Model 
relationships using Excel 2013, Power Pivot, and DAX.Create Map-based Power 
View Reports. Incorporate Internet Data, and Set Power View Report Defaults. 

Create Amazing Power View Reports. 

6. Sparkline’s Group  

Line This option is used to insert a line chart within a single cell. When the button is 

clicked a dialog box will appear asking for the range of data that is to be plotted 

Column Use this option to insert a column chart within a single cell. When the 

button is clicked a dialog box will appear asking for the range of data that is to be 

plotted. 

Win/Loss To insert a win/loss chart into a single cell, select this option. When the 

button is clicked a dialog box will appear asking for the range of data that is to be 

plotted.  

7. Filter Group  

Slicer A slicer is used to filter data interactively. This makes it faster and easier to 

filter Pivot Tables, Pivot Charts, and cube functions.  

Timeline This feature is used to filter dates interactively. This makes it faster and 

easier to select time periods in order to filter Pivot Tables, Pivot Charts, and cube 

functions.  

8. Links Group  

Hyperlink To insert a link to another worksheet, a Web site, another program, a 

picture, or an e-mail address, click this button.  

9. Text Group 

Text Box This button is used to insert a textbox into the worksheet. Text boxes can 

be used to highlight an item in a chart or within the worksheet. Textboxes can be 

inserted and/or positioned anywhere within the worksheet page.  

Header and Footer To insert a header and/or footer into a worksheet, click this 

button. The header or footer area of the worksheet will display when this button is 

clicked. The header or footer can be inserted directly into this area.  



Word Art Click this button to insert a Word Art object into the worksheet or chart. 

A gallery of Word Art styles will appear. Select any of the styles to display the text 

box. The text box is where the text for the Word Art can be specified.  

Signature Line Use this button to insert a signature line into the worksheet. The 

signature line specifies the individual who is to sign the file in order to access it. 

Object To insert an embedded object, such as documents from other programs, 

click this button. A dialog box will display from which a list of options can be 

chosen. Click the Create from File option to insert a designated file.  

10. Symbols Group  

Equation This button is used to insert a mathematical equation into a document. 

The equation tools ribbon will appear when the button is clicked. This ribbon is 

used to create the equation. A list of common equations is also available.  

Symbol This button is used to insert a symbol, such as a copyright symbol, into the 

worksheet. When the button is clicked, a gallery of different symbols will appear. 

 

PAGE LAYOUT TAB 

1. Theme 

Themes - Drop-Down. Changes the overall look and feel of your workbook 
including colours, fonts and effects. The drop-down contains the commands: Built-
in, More Themes on Microsoft Office Articles (Removed in 2010), Browse for 
Themes and Save Current Theme. The built-in themes are: Office, Facet, Integral, 
Ion, Boardroom, Organic, Retrospect, Slice, Wisp, Berlin and Frame. Tooltip 
indicates the current theme. The default theme is "Office". 
Colors - Drop-Down. Displays a list of all the available colours and lets you change 
the colour component of the active theme. The drop-down contains the 
commands: Built-in and Customize Colors. 
Fonts - Drop-Down. Displays a list of all the available fonts and lets you change the 
font component of the active theme. The drop-down contains the commands: 
Built-in and Customize Fonts. 
Effects - Drop-Down. Displays a list of all the available effects and lets you change 
the effect component of the active theme. The drop-down contains the 
commands: Office, Office 2007-2010, Subtle Solids, Banded Edges, Smokey Glass, 
Glow Edge, Grunge Texture, Frosted Glass, Top Shadow, Inset, Milk Glass, Riblet, 
Reflection, Extreme Shadow, Glossy. 

 
 



2. Page Setup 

You can quickly display the "Page Setup" dialog box, Page tab, by clicking on the 
launcher in the bottom right corner of this group. 

Margins - Drop-Down. Lets you choose from one of your built-in margin settings or 
lets you customise your own. The drop-down contains the commands: Normal, 
Wide, Narrow and Custom Margins. The Custom Margins displays the "Page Setup" 
dialog box, Margins tab. 
Orientation - Drop-Down. Lets you switch between Portrait and Landscape. 
Size - Drop-Down. Lets you select from all the different available paper sizes. The 
More Paper Sizes displays the "Page Setup" dialog box, Page tab. 
Print Area - Drop-Down. This drop-down contains the commands: Set Print Area 
and Clear Print Area. 
Breaks - Drop-Down. This drop-down contains the commands: Insert Page Break, 
Remove Page Break and Reset All Page Breaks. 
Background - Displays the "Sheet Background" dialog box to let you add a 
background image to the back of a worksheet. This caption changes to 'Delete 
Background' if an image is assigned to the active worksheet. 
Print Titles - Displays the "Page Setup" dialog box, Sheet tab. This allows you to 
enter rows or columns to repeat. 

 
 

3. Scale to Fit 

You can quickly display the "Page Setup" dialog box, Page tab, by clicking on the 
launcher in the bottom right corner of this group. 

Width - Choice of 1 to 9 pages. The combo box contains Automatic, 1 to 9 pages 
and More Pages. The More Pages displays the "Page Setup" dialog box, Page tab. 
Provides a shortcut to (Page Setup)(Page tab, Scaling). 
Height - Choice of 1 to 9 pages. The combo box contains Automatic, 1 to 9 pages 
and More Pages. The More Pages displays the "Page Setup" dialog box, Page tab. 
Provides a shortcut to (Page Setup)(Page tab, Scaling). 
Scale - Changes the page scale in increments of 5%. Provides a shortcut to the 
(Page Setup)(Page tab, Scaling). 

 
 

4. Sheet Options 



You can quickly display the "Page Setup" dialog box, Sheet tab, by clicking on the 
launcher in the bottom right corner of this group. 

Sheet right to left - In order to move one sheet to the right, hold down Ctrl, then 
press the PgDn key. To keep moving to the right, press the PgDn key again. In order 
to move back or one sheet to the left, hold down Ctrl, then press the PgUp key. To 
keep moving to the left, press the PgUp key again. 

Gridlines View - Toggles the display of gridlines on the active worksheet. Provides a 
shortcut to (Page Setup)(Sheet tab, "Gridlines"). 
Gridlines Print - Toggles whether the gridlines are printed. Provides a shortcut to 
(Excel Options)(Advanced tab, "Show gridlines"). 
Headings View - Toggles the displays of row and column headers on the active 
worksheet. Provides a shortcut to (Excel Options)(Advanced tab, "Show row and 
column headers"). 
Headings Print - Toggles whether the row and column headers are printed. 
Provides a shortcut to (Page Setup)(Sheet tab, "Row and column headings"). 

5. Arrange 

This whole group also appears on the Drawing Tools - Format Tab, Picture Tools - 
Format Tab. 
Bring Forward - Button with Drop-Down. The button brings the selected object 
forward one level. The drop-down contains the commands: Bring to Front and 
Bring Forward. Bring to Front will bring the selected object in front of all the other 
objects. 
Send Backward - Button with Drop-Down. The button brings the selected object 
back one level. The drop-down contains the commands: Send to Back and Send 
Backward. Send to Back will send the selected object to the back of all the other 
objects. 
Selection Pane - Drop-Down. Displays the Selection Task Pane. 
Align - Drop-Down. This drop-down contains the commands: Align Left, Align 
Center, Align Right, Align Top, Align Middle, Align Bottom, Distribute Horizontally, 
Distribute Vertically, Snap to Grid, Snap to Shape, View Gridlines. 
Align (Word extras) Align to Page, Align to Margin, Align Selected Objects, View 
Gridlines and Grid Settings. 
Align (PowerPoint extras) Align to Slide, Align Selected Objects, View Gridlines and 
View Settings. 
Group - Drop-Down. This drop-down contains the commands: Group, Regroup and 
Ungroup. 
Rotate - Rotate or flip the selected object. Drop-Down. This drop-down contains 



the commands: Rotate Right 90, Rotate Left 90, Flip Vertical, Flip Horizontal and 
More Rotation Options. 

 

FORMULAS TAB 
Compatibility Excel Formulas & Functions 

Functions Excel Formulas Description 

CONCATENAT

E 

=CONCATENATE(tex

t1,text2,…) 
Joins several text items into one text item. Easier 

to use ‘&’ instead of the function usually. 

FLOOR =FLOOR(number,sig

nificance) 
Rounds a number down, toward zero 

BINOMDIST =BINOMDIST(numb

er_s,trials,probabilit

y_s,cumulative) 

Returns the individual term binomial distribution 

probability 

CHIDIST =CHIDIST(x,deg_fre

edom) 
Returns the one-tailed probability of the chi-

squared distribution 

CHIINV =CHITEST(actual_ra

nge,expected_range

) 

Returns the test for independence 

CONFIDENCE =CONFIDENCE(alph

a,standard_dev,size

) 

Returns the confidence interval for a population 

mean 

FTEST =FTEST(array1,array

2) 
  

LOGINV =LOGINV(probabilit

y,mean,standard_d

ev) 

Returns the inverse of the lognormal cumulative 

distribution 



LOGNORMDIS

T 

=LOGNORMDIST(x,

mean,standard_dev

) 

Returns the cumulative lognormal distribution 

MODE ==MODE(number1,

number2,…) 
Returns the most common value in a data set 

NORMDIST =NORMDIST(x,mean

,standard_dev,cum

ulative) 

Returns the normal cumulative distribution 

NORMINV =NORMINV(probabi

lity,mean,standard_

dev) 

Returns the inverse of the normal cumulative 

distribution 

NORMSDIST =NORMSDIST(z) Returns the standard normal cumulative 

distribution 

NORMSINV =NORMSINV(proba

bility) 
Returns the inverse of the standard normal 

cumulative distribution 

PERCENTILE =PERCENTILE(array,

k) 
Returns the k-th percentile of values in a range 

PERCENTRAN

K 

=PERCENTRANK(arr

ay,x,significance) 
Returns the percentage rank of a value in a data 

set 

POISSON =POISSON(x,mean,c

umulative) 
Returns the Poisson distribution 

QUARTILE =QUARTILE(array,qu

art) 
Returns the quartile of a data set 

RANK =RANK(number,ref,

order) 
Returns the rank of a number in a list of 

numbers 

STDEV =STDEV(number1,n

umber2,…) 
Estimates standard deviation based on a sample 



STDEVP =STDEVP(number1,

number2,…) 
Calculates standard deviation based on the 

entire population 

TDIST =TDIST(x,deg_fr

eedom,tails) 
Returns the Student’s t-distribution 

TINV =TINV(probabili

ty,deg_freedom

) 

Returns the inverse of the Student’s t-

distribution 

VAR =VAR(number1,num

ber2,…) 

Estimates variance based on a sample 

VARP =VARP(number1,nu

mber2,…) 

Calculates variance based on the entire population 

FINV =FINV(probability,d

eg_freedom1,deg_f

reedom2) 

Returns the inverse of the F probability distribution 

FORECAST =FORECAST(x,know

n_y’s,known_x’s) 

Returns a value along a linear trend 

BETADIST =BETADIST(x,alpha,

beta,A,B) 

Returns the beta cumulative distribution function 

BETAINV =BETAINV(probabili

ty,alpha,beta,A,B) 

Returns the inverse of the cumulative distribution 

function for a specified beta distribution 

COVAR =COVAR(array1,arra

y2) 

Returns covariance, the average of the products of 

paired deviations 

CRITBINOM =CRITBINOM(trials,

probability_s,alpha) 

Returns the smallest value for which the cumulative 

binomial distribution is less than or equal to a 

criterion value 

EXPONDIST =EXPONDIST(x,lamb

da,cumulative) 

Returns the exponential distribution 



POISSON =POISSON(x,mean,c

umulative) 

Returns the Poisson distribution 

FDIST =FDIST(x,deg_freed

om1,deg_freedom2

) 

Returns the F probability distribution 

GAMMADIST =GAMMADIST(x,alp

ha,beta,cumulative) 

Returns the gamma distribution 

GAMMAINV =GAMMAINV(proba

bility,alpha,beta) 

Returns the inverse of the gamma cumulative 

distribution 

HYPGEOMDIS

T 

=HYPGEOMDIST(sa

mple_s,number_sa

mple,population_s,

number_pop) 

Returns the hypergeometric distribution 

NEGBINOMDI

ST 

=NEGBINOMDIST(n

umber_f,number_s,

probability_s) 

Returns the negative binomial distribution 

TTEST =TTEST(array1,array

2,tails,type) 

Returns the probability associated with a Student’s 

t-test 

WEIBULL =WEIBULL(x,alpha,b

eta,cumulative) 

Calculates variance based on the entire population, 

including numbers, text, and logical values 

ZTEST =ZTEST(array,x,sigm

a) 

Returns the one-tailed probability-value of a z-test 

 Cube Excel Formulas & Functions 

Functions Excel 

Formulas 
Description 

CUBEKPIMEM

BER 

=CUBEKPI

MEMBER(c

onnection,

Returns a key performance indicator (KPI) name, property, and 

measure, and displays the name and property in the cell. A KPI is 

a quantifiable measurement, such as monthly gross profit or 



kpi_name,

kpi_proper

ty,caption) 

quarterly employee turnover, used to monitor an organization’s 

performance. 

CUBEMEMBE

R 

=CUBEME

MBER(con

nection,me

mber_expr

ession,capt

ion) 

RReturns a member or tuple in a cube hierarchy. Use to validate 

that the member or tuple exists in the cube. 

CUBEMEMBE

RPROPERTY 

=CUBEME

MBERPRO

PERTY(con

nection,me

mber_expr

ession,pro

perty) 

Returns the value of a member property in the cube. Use to 

validate that a member name exists within the cube and to 

return the specified property for this member. 

CUBERANKED

MEMBER 

=CUBERAN

KEDMEMB

ER(connect

ion,set_ex

pression,ra

nk,caption) 

Returns the nth, or ranked, member in a set. Use to return one 

or more elements in a set, such as the top sales performer or 

top 10 students. 

CUBESET =CUBESET(

connection

,set_expre

ssion,capti

on,sort_or

der,sort_b

y) 

Defines a calculated set of members or tuples by sending a set 

expression to the cube on the server, which creates the set, and 

then returns that set to Microsoft Office Excel. 

CUBESETCOU

NT 

=CUBESET

COUNT(set

) 

Returns the number of items in a set. 

CUBEVALUE =CUBEVAL

UE(connec

tion,memb

er_express

ion1,…) 

Returns an aggregated value from a cube 



 Database Excel Formulas & Functions 

Functions Excel Formulas Description 

DGET =DGET(database,field,c

riteria) 

Extracts from a database a single record that 

matches the specified criteria 

DSUM =DSUM(database,field,

criteria) 

Adds the numbers in the field column of records in 

the database that match the criteria 

DAVERAGE =DAVERAGE(database,

field,criteria) 

Returns the average of selected database entries 

DCOUNT =DCOUNT(database,fie

ld,criteria) 

Counts the cells that contain numbers in a database 

DCOUNTA =DCOUNTA(database,fi

eld,criteria) 

Counts nonblank cells in a database 

DMAX =DMAX(database,field,

criteria) 

Returns the maximum value from selected database 

entries 

DMIN =DMIN(database,field,

criteria) 

Returns the minimum value from selected database 

entries 

DPRODUCT =DPRODUCT(database,

field,criteria) 

Multiplies the values in a particular field of records 

that match the criteria in a database 

DSTDEV =DSTDEV(database,fiel

d,criteria) 

Estimates the standard deviation based on a sample 

of selected database entries 

DSTDEVP =DSTDEVP(database,fie

ld,criteria) 

Calculates the standard deviation based on the 

entire population of selected database entries 

DVAR =DVAR(database,field,c

riteria) 

Estimates variance based on a sample from selected 

database entries 

DVARP =DVARP(database,field

,criteria) 

Calculates variance based on the entire population 

of selected database entries 



 Date & Time Excel Formulas & Functions 

Functions Excel Formulas Description 

DATE 
=DATE(year,month,day

) 
Returns the serial number of a particular date 

DATEVALUE 
=DATEVALUE(date_tex

t) 

Converts a date in the form of text to a serial 

number 

DAY =DAY(serial_number) Converts a serial number to a day of the month 

HOUR =HOUR(serial_number) Converts a serial number to an hour 

MINUTE 
=MINUTE(serial_numb

er) 
Converts a serial number to a minute 

MONTH 
==MONTH(serial_num

ber) 
Converts a serial number to a month 

NOW =NOW() 
Returns the serial number of the current date and 

time 

SECOND 
=SECOND(serial_numb

er) 
Converts a serial number to a second 

TIME 
=TIME(hour,minute,sec

ond) 
Returns the serial number of a particular time 

TIMEVALUE 
=TIMEVALUE(time_text

) 

Converts a time in the form of text to a serial 

number 

TODAY =TODAY() Returns the serial number of today’s date 

YEAR =YEAR(serial_number) Converts a serial number to a year 

DAYS360 
=DAYS360(start_date,e

nd_date,method) 

Calculates the number of days between two dates 

based on a 360-day year 



EDATE 
=EDATE(start_date,mo

nths) 

Returns the serial number of the date that is the 

indicated number of months before or after the 

start date 

EOMONTH 
=EOMONTH(start_date

,months) 

Returns the serial number of the last day of the 

month before or after a specified number of months 

NETWORKDA

YS 

=NETWORKDAYS(start

_date,end_date,[holida

ys]) 

Returns the number of whole workdays between 

two dates 

NETWORKDA

YS.INTL 

=NETWORKDAYS.INTL(

start_date,end_date,[

weekend],[holidays]) 

Returns the number of whole workdays between 

two dates using parameters to indicate which and 

how many days are weekend days 

WEEKDAY 
=WEEKDAY(serial_num

ber,[return_type]) 
Converts a serial number to a day of the week 

WEEKNUM 
=WEEKNUM(serial_nu

mber,[return_type]) 

Converts a serial number to a number representing 

where the week falls numerically with a year 

WORKDAY 
=WORKDAY(start_date

, days, [holidays]) 

Returns the serial number of the date before or 

after a specified number of workdays 

WORKDAY.IN

TL 

=WORKDAY.INTL(start_

date,days,weekend,hol

idays) 

Returns the serial number of the date before or 

after a specified number of workdays using 

parameters to indicate which and how many days 

are weekend days 

YEARFRAC 
=YEARFRAC(start_date,

end_date,basis) 

Returns the year fraction representing the number 

of whole days between start_date and end_date 

 Information Excel Formulas & Functions 

Functions Excel Formulas Description 

CELL 
=CELL(info_type, 

[reference]) 

Returns information about the formatting, location, 

or contents of a cell 



ISBLANK =ISBLANK(value) Returns TRUE if the value is blank 

ISERROR =ISERROR(value) Returns TRUE if the value is any error value 

ISNONTEXT =ISNONTEXT(value) Returns TRUE if the value is not text 

ISNUMBER =ISNUMBER(value) Returns TRUE if the value is a number 

ISTEXT =ISTEXT(value) Returns TRUE if the value is text 

ERROR.TYPE 
=ERROR.TYPE(error_val

) 
Returns a number corresponding to an error type 

INFO =INFO(type_text) 
Returns information about the current operating 

environment 

ISERR =ISERR(value) 
Returns TRUE if the value is any error value except 

#N/A 

ISEVEN =ISEVEN(number) Returns TRUE if the number is even 

ISLOGICAL =ISLOGICAL(value) Returns TRUE if the value is a logical value 

ISNA =ISNA(value) Returns TRUE if the value is the #N/A error value 

ISODD =ISODD(number) Returns TRUE if the number is odd 

ISREF =ISREF(value) Returns TRUE if the value is a reference 

N =N(value) Returns a value converted to a number 

NA =NA() Returns the error value #N/A 

TYPE =TYPE(value) Returns a number indicating the data type of a value 



 Logical Excel Formulas & Functions 

Functions Excel Formulas Description 

AND 
=AND(logical1,logical2,

…) 
Returns TRUE if all of its arguments are TRUE 

FALSE =FALSE Returns the logical value FALSE 

IF 

=IF(logical_test, 

[value_if_true], 

[value_if_false]) 

Specifies a logical test to perform 

IFERROR 
=IFERROR(value, 

value_if_error) 

Returns a value you specify if a formula evaluates 

to an error; otherwise, returns the result of the 

formula 

NOT =NOT(logical) Reverses the logic of its argument 

OR 
=OR(logical1,logical2,…

) 
Returns TRUE if any argument is TRUE 

TRUE =TRUE Returns the logical value TRUE 

LOOKUP 
=LOOKUP(lookup_valu

e, array)– 2 types 
Looks up values in a vector or array 

 Lookup & Reference Excel Formulas & Functions 

Functions Excel Formulas Description 

ADDRESS =ADDRESS(row_num, 

column_num, 

[abs_num], [a1], 

[sheet_text]) 

Returns a reference as text to a single cell in a 

worksheet 



COLUMN =COLUMN([reference

]) 

Returns the column number of a reference 

COLUMNS =COLUMNS(array) Returns the number of columns in a reference 

HLOOKUP =HLOOKUP(lookup_v

alue,table_array,row_

index_num,[range_lo

okup]) 

Looks in the top row of an array and returns the 

value of the indicated cell 

INDEX =INDEX(array,row_nu

m,[column_num])– 2 

types 

Uses an index to choose a value from a reference 

or array 

INDIRECT =INDIRECT(ref_text,a

1) 

Returns a reference indicated by a text value 

MATCH =MATCH(lookup_valu

e,lookup_array,match

_type) 

Looks up values in a reference or array 

OFFSET =OFFSET(reference,ro

ws,cols,height,width) 

Returns a reference offset from a given reference 

ROW =ROW([reference]) Returns the row number of a reference 

ROWS =ROWS(array) Returns the number of rows in a reference 

VLOOKUP =VLOOKUP(lookup_va

lue,table_array,col_in

dex_num,[range_look

up]) 

Looks in the first column of an array and moves 

across the row to return the value of a cell 

CHOOSE =CHOOSE(index_num

,value1,value2,…) 

Chooses a value from a list of values 

GETPIVOTDATA =GETPIVOTDATA(data

_field,pivot_table,fiel

d,item,…) 

Returns data stored in a PivotTable report 



HYPERLINK =HYPERLINK(link_loca

tion,friendly_name) 

Creates a shortcut or jump that opens a document 

stored on a network server, an intranet, or the 

Internet 

TRANSPOSE =TRANSPOSE(array) Returns the transpose of an array 

AREAS =AREAS(reference) Returns the number of areas in a reference 

RTD =RTD(progID,server,t

opic1,topic2,…) 

Retrieves real-time data from a program that 

supports COM automation (Automation: A way to 

work with an application’s objects from another 

application or development tool. Formerly called 

OLE Automation, Automation is an industry-

standard and a feature of the Component Object 

Model (COM).) 

 Text Excel Formulas & Functions 

Functions Excel Formulas Description 

EXACT =EXACT(text1,text2) Checks to see if two text values are identical 

LOWER =LOWER(text) Converts text to lowercase 

PROPER =PROPER(text) Capitalizes the first letter in each word of a text 

value 

TRIM =TRIM(text) Removes spaces from text 

UPPER =UPPER(text) Converts text to uppercase 

CHAR =CHAR(number) Returns the character specified by the code 

number 

CLEAN =CLEAN(text) Removes all nonprintable characters from text 



CODE =CODE(text) Returns a numeric code for the first character in a 

text string 

DOLLAR =DOLLAR(number,dec

imals) 

Converts a number to text, using the $ (dollar) 

currency format 

FIXED =FIXED(number,decim

als,no_commas) 

Formats a number as text with a fixed number of 

decimals 

PHONETIC =PHONETIC(reference

) 

Extracts the phonetic (furigana) characters from a 

text string 

REPT =REPT(text,number_ti

mes) 

Repeats text a given number of times 

SUBSTITUTE =SUBSTITUTE(text,old

_text,new_text,instan

ce_num) 

Substitutes new text for old text in a text string 

T =T(value) Converts its arguments to text 

VALUE =VALUE(text) Converts a text argument to a number 

ASC =ASC(text) Changes full-width (double-byte) English letters or 

katakana within a character string to half-width 

(single-byte) characters 

BAHTTEXT =BAHTTEXT(number) Converts a number to text, using the ß (baht) 

currency format 

 Most Common Excel Formulas & Functions 

Functions Excel Formulas Description 

FIND =FIND(find_text,withi

n_text,start_num) 

Finds one text value within another (case-sensitive) 



LEFT =LEFT(text,num_chars

) 

Returns the leftmost characters from a text value 

LEN =LEN(text) Returns the number of characters in a text string 

MID =MID(text,start_num,

num_chars) 

Returns a specific number of characters from a text 

string starting at the position you specify 

REPLACE =REPLACE(old_text,st

art_num,num_chars,n

ew_text) 

Replaces characters within text 

RIGHT =RIGHT(text,num_cha

rs) 

Returns the rightmost characters from a text value 

SEARCH =SEARCH(find_text,wi

thin_text,start_num) 

Finds one text value within another (not case-

sensitive) 

 Engineering Excel Formulas & Functions 

Functions Excel Formulas Description 

CONVERT =CONVERT(number,fr

om_unit,to_unit) 

Converts a number from one measurement system 

to another 

DELTA =DELTA(number1,nu

mber2) 

Tests whether two values are equal 

ERF =ERF(lower_limit,upp

er_limit) 

Returns the error function 

ERFC =ERFC(x) Returns the complementary error function 

GESTEP =GESTEP(number,step

) 

Tests whether a number is greater than a threshold 

value 

ERF.PRECISE =ERF.PRECISE(X) Returns the error function 



ERFC.PRECISE =ERFC.PRECISE(X) Returns the complementary ERF function 

integrated between x and infinity 

BESSELI =BESSELI(x,n) Returns the modified Bessel function In(x) 

BESSELJ =BESSELJ(x,n) Returns the Bessel function Jn(x) 

BESSELK =BESSELK(x,n) Returns the modified Bessel function Kn(x) 

BESSELY =BESSELY(x,n) Returns the Bessel function Yn(x) 

BIN2DEC =BIN2DEC(number) Converts a binary number to decimal 

BIN2HEX =BIN2HEX(number,pla

ces) 

Converts a binary number to hexadecimal 

DEC2OCT =DEC2OCT(number,pl

aces) 

Converts a decimal number to octal 

HEX2BIN =HEX2BIN(number,pla

ces) 

Converts a hexadecimal number to binary 

HEX2DEC =HEX2DEC(number) Converts a hexadecimal number to decimal 

HEX2OCT =HEX2OCT(number,pl

aces) 

Converts a hexadecimal number to octal 

IMABS =IMABS(inumber) Returns the absolute value (modulus) of a complex 

number 

IMAGINARY =IMAGINARY(inumber

) 

Returns the imaginary coefficient of a complex 

number 

IMARGUMENT =IMARGUMENT(inum

ber) 

Returns the argument theta, an angle expressed in 

radians 

IMCONJUGATE =IMCONJUGATE(inum

ber) 

Returns the complex conjugate of a complex 

number 



IMCOS =IMCOS(inumber) Returns the cosine of a complex number 

IMDIV =IMDIV(inumber1,inu

mber2) 

Returns the quotient of two complex numbers 

IMEXP =IMEXP(inumber) Returns the exponential of a complex number 

IMLN =IMLN(inumber) Returns the natural logarithm of a complex number 

IMLOG10 =IMLOG10(inumber) Returns the base-10 logarithm of a complex 

number 

IMLOG2 =IMLOG2(inumber) Returns the base-2 logarithm of a complex number 

IMPOWER =IMPOWER(inumber,

number) 

Returns a complex number raised to an integer 

power 

IMPRODUCT =IMPRODUCT(inumbe

r1,inumber2,…) 

Returns the product of complex numbers 

IMREAL =IMREAL(inumber) Returns the real coefficient of a complex number 

IMSIN =IMSIN(inumber) Returns the sine of a complex number 

IMSQRT =IMSQRT(inumber) Returns the square root of a complex number 

IMSUB =IMSUB(inumber1,inu

mber2) 

Returns the difference between two complex 

numbers 

IMSUM =IMSUM(inumber1,in

umber2,…) 

Returns the sum of complex numbers 

OCT2BIN =OCT2BIN(number,pl

aces) 

Converts an octal number to binary 

OCT2DEC =OCT2DEC(number) Converts an octal number to decimal 



OCT2HEX =OCT2HEX(number,pl

aces) 

Converts an octal number to hexadecimal 

 Financial Excel Formulas & Functions 

Functions Excel Formulas Description 

AMORDEGRC =AMORDEGRC(cost,d

ate_purchased,first_p

eriod,salvage,period,r

ate,basis) 

Returns the depreciation for each accounting 

period by using a depreciation coefficient 

AMORLINC =AMORLINC(cost,date

_purchased,first_peri

od,salvage,period,rate

,basis) 

Returns the depreciation for each accounting 

period 

DOLLARDE =DOLLARDE(fractional

_dollar,fraction) 

Converts a dollar price, expressed as a fraction, 

into a dollar price, expressed as a decimal number 

DOLLARFR =DOLLARFR(decimal_

dollar,fraction) 

Converts a dollar price, expressed as a decimal 

number, into a dollar price, expressed as a fraction 

SLN =SLN(cost,salvage,life) Returns the straight-line depreciation of an asset 

for one period 

SYD =SYD(cost,salvage,life,

per) 

Returns the sum-of-years’ digits depreciation of an 

asset for a specified period 

DB =DB(cost,salvage,life,

period,month) 

Returns the depreciation of an asset for a specified 

period by using the fixed-declining balance method 

DDB =DDB(cost,salvage,life

,period,factor) 

Returns the depreciation of an asset for a specified 

period by using the double-declining balance 

method or some other method that you specify 

EFFECT =EFFECT(nominal_rat

e,npery) 

Returns the effective annual interest rate 



FV =FV(rate,nper,pmt,pv,

type) 

Returns the future value of an investment 

IPMT =IPMT(rate,per,nper,p

v,fv,type) 

Returns the interest payment for an investment for 

a given period 

IRR =IRR(values,guess) Returns the internal rate of return for a series of 

cash flows 

MIRR =MIRR(values,finance

_rate,reinvest_rate) 

Returns the internal rate of return where positive 

and negative cash flows are financed at different 

rates 

NOMINAL =NOMINAL(effect_rat

e,npery) 

Returns the annual nominal interest rate 

NPER =NPER(rate,pmt,pv,fv,

type) 

Returns the number of periods for an investment 

NPV =NPV(rate,value1,valu

e2,…) 

Returns the net present value of an investment 

based on a series of periodic cash flows and a 

discount rate 

PV =PV(rate,nper,pmt,fv,

type) 

Returns the present value of an investment 

RATE =RATE(nper,pmt,pv,fv

,type,guess) 

Returns the interest rate per period of an annuity 

YIELD =YIELD(settlement,ma

turity,rate,pr,redempt

ion,frequency,basis) 

Returns the yield on a security that pays periodic 

interest 

ACCRINT =ACCRINT(issue,first_i

nterest,settlement,rat

e,par,frequency,basis,

calc_method) 

Returns the accrued interest for a security that 

pays periodic interest 

ACCRINTM =ACCRINTM(issue,sett

lement,rate,par,basis) 

Returns the accrued interest for a security that 

pays interest at maturity 



COUPDAYBS =COUPDAYBS(settlem

ent,maturity,frequenc

y,basis) 

Returns the number of days from the beginning of 

the coupon period to the settlement date 

COUPDAYS =COUPDAYS(settleme

nt,maturity,frequency

,basis) 

Returns the number of days in the coupon period 

that contains the settlement date 

COUPDAYSNC =COUPDAYSNC(settle

ment,maturity,freque

ncy,basis) 

Returns the number of days from the settlement 

date to the next coupon date 

COUPNCD =COUPNCD(settlemen

t,maturity,frequency,

basis) 

Returns the next coupon date after the settlement 

date 

COUPNUM =COUPNUM(settleme

nt,maturity,frequency

,basis) 

Returns the number of coupons payable between 

the settlement date and maturity date 

COUPPCD =COUPPCD(settlemen

t,maturity,frequency,

basis) 

Returns the previous coupon date before the 

settlement date 

CUMIPMT =CUMIPMT(rate,nper,

pv,start_period,end_p

eriod,type) 

Returns the cumulative interest paid between two 

periods 

CUMPRINC =CUMPRINC(rate,nper

,pv,start_period,end_

period,type) 

Returns the cumulative principal paid on a loan 

between two periods 

DISC =DISC(settlement,mat

urity,pr,redemption,b

asis) 

Returns the discount rate for a security 

DURATION =DURATION(settleme

nt,maturity,coupon,yl

d,frequency,basis) 

Returns the annual duration of a security with 

periodic interest payments 



FVSCHEDULE =FVSCHEDULE(princip

al,schedule) 

Returns the future value of an initial principal after 

applying a series of compound interest rates 

INTRATE =INTRATE(settlement,

maturity,investment,r

edemption,basis) 

Returns the interest rate for a fully invested 

security 

ISPMT =ISPMT(rate,per,nper,

pv) 

Calculates the interest paid during a specific period 

of an investment 

MDURATION =MDURATION(settle

ment,maturity,coupo

n,yld,frequency,basis) 

Returns the Macauley modified duration for a 

security with an assumed par value of $100 

ODDFPRICE =ODDFPRICE(settleme

nt,maturity,issue,first

_coupon,rate,yld,rede

mption,frequency,bas

is) 

Returns the price per $100 face value of a security 

with an odd first period 

ODDFYIELD =ODDFYIELD(settleme

nt,maturity,issue,first

_coupon,rate,pr,rede

mption,frequency,bas

is) 

Returns the yield of a security with an odd first 

period 

ODDLPRICE =ODDLPRICE(settleme

nt,maturity,last_inter

est,rate,yld,redemptio

n,frequency,basis) 

Returns the price per $100 face value of a security 

with an odd last period 

ODDLYIELD =ODDLYIELD(settleme

nt,maturity,last_inter

est,rate,pr,redemptio

n,frequency,basis) 

Returns the yield of a security with an odd last 

period 

PMT =PMT(rate,nper,pv,fv,

type) 

Returns the periodic payment for an annuity 

PPMT =PPMT(rate,per,nper,

pv,fv,type) 

Returns the payment on the principal for an 

investment for a given period 



PRICE =PRICE(settlement,ma

turity,rate,yld,redemp

tion,frequency,basis) 

Returns the price per $100 face value of a security 

that pays periodic interest 

PRICEDISC =PRICEDISC(settlemen

t,maturity,discount,re

demption,basis) 

Returns the price per $100 face value of a 

discounted security 

PRICEMAT =PRICEMAT(settleme

nt,maturity,issue,rate,

yld,basis) 

Returns the price per $100 face value of a security 

that pays interest at maturity 

RECEIVED =RECEIVED(settlemen

t,maturity,investment

,discount,basis) 

Returns the amount received at maturity for a fully 

invested security 

TBILLEQ =TBILLEQ(settlement,

maturity,discount) 

Returns the bond-equivalent yield for a Treasury 

bill 

TBILLPRICE =TBILLPRICE(settleme

nt,maturity,discount) 

Returns the price per $100 face value for a 

Treasury bill 

TBILLYIELD =TBILLYIELD(settleme

nt,maturity,pr) 

Returns the yield for a Treasury bill 

VDB =VDB(cost,salvage,life

,start_period,end_per

iod,factor,no_switch) 

Returns the depreciation of an asset for a specified 

or partial period by using a declining balance 

method 

XIRR =XIRR(values,dates,gu

ess) 

Returns the internal rate of return for a schedule of 

cash flows that is not necessarily periodic 

XNPV =XNPV(rate,values,dat

es) 

Returns the net present value for a schedule of 

cash flows that is not necessarily periodic 

YIELDDISC =YIELDDISC(settlemen

t,maturity,pr,redempt

ion,basis) 

Returns the annual yield for a discounted security; 

for example, a Treasury bill 



YIELDMAT =YIELDMAT(settlemen

t,maturity,issue,rate,p

r,basis) 

Returns the annual yield of a security that pays 

interest at maturity 

 Math and Trigonometry Excel Formulas & Functions 

Functions Excel Formulas Description 

ABS =ABS(number) Returns the absolute value of a number 

PRODUCT =PRODUCT(number1,

number2,…) 

Multiplies its arguments 

RAND =RAND() Returns a random number between 0 and 1 

RANDBETWEE

N 

=RANDBETWEEN(bott

om,top) 

Returns a random number between the numbers 

you specify 

ROUND =ROUND(number,nu

m_digits) 

Rounds a number to a specified number of digits 

ROUNDDOWN =ROUNDDOWN(numb

er,num_digits) 

Rounds a number down, toward zero 

ROUNDUP =ROUNDUP(number,n

um_digits) 

Rounds a number up, away from zero 

SUBTOTAL =SUBTOTAL(function_

num,ref1,…) 

Returns a subtotal in a list or database 

SUM =SUM(number1,numb

er2,…) 

Adds its arguments 

SUMIF =SUMIF(range,criteria

,[sum_range]) 

Adds the cells specified by a given criteria 



SUMIFS =SUMIFS(sum_range,c

riteria_range,criteria,

…) 

Adds the cells in a range that meet multiple criteria 

SUMPRODUCT =SUMPRODUCT(array

1,array2,[array3],…) 

Returns the sum of the products of corresponding 

array components 

CEILING =CEILING(number,sign

ificance) 

Rounds a number to the nearest integer or to the 

nearest multiple of significance 

CEILING.PRECI

SE 

=CEILING.PRECISE(nu

mber,significance) 

Rounds a number the nearest integer or to the 

nearest multiple of significance. Regardless of the 

sign of the number, the number is rounded up. 

EVEN =EVEN(number) Rounds a number up to the nearest even integer 

EXP =EXP(number) Returns e raised to the power of a given number 

FACT =FACT(number) Returns the factorial of a number 

FLOOR.PRECIS

E 

=FLOOR.PRECISE(num

ber,significance) 

Rounds a number the nearest integer or to the 

nearest multiple of significance. Regardless of the 

sign of the number, the number is rounded up. 

GCD =GCD(number1,numb

er2,…) 

Returns the greatest common divisor 

INT =INT(number) Rounds a number down to the nearest integer 

ISO.CEILING =ISO.CEILING(number,

significance) 

Returns a number that is rounded up to the 

nearest integer or to the nearest multiple of 

significance 

LCM =LCM(number1,numb

er2,…) 

Returns the least common multiple 

MOD =MOD(number,divisor

) 

Returns the remainder from division 



MROUND =MROUND(number,m

ultiple) 

Returns a number rounded to the desired multiple 

ODD =ODD(number) Rounds a number up to the nearest odd integer 

PI =PI() Returns the value of pi 

POWER =POWER(number,po

wer) 

Returns the result of a number raised to a power 

QUOTIENT =QUOTIENT(numerat

or,denominator) 

Returns the integer portion of a division 

SERIESSUM =SERIESSUM(x,n,m,co

efficients) 

Returns the sum of a power series based on the 

formula 

SIGN =SIGN(number) Returns the sign of a number 

SQRT =SQRT(number) Returns a positive square root 

SUMSQ =SUMSQ(number1,nu

mber2,…) 

Returns the sum of the squares of the arguments 

TRUNC =TRUNC(number,num

_digits) 

Truncates a number to an integer 

AGGREGATE =AGGREGATE(functio

n_num,options,array,

k) 

Returns an aggregate in a list or database 

COMBIN =COMBIN(number,nu

mber_chosen) 

Returns the number of combinations for a given 

number of objects 

COS =COS(number) Returns the cosine of a number 

COSH =COSH(number) Returns the hyperbolic cosine of a number 

FACTDOUBLE =FACTDOUBLE(numbe

r) 

Returns the double factorial of a number 



LN =LN(number) Returns the natural logarithm of a number 

LOG =LOG(number,base) Returns the logarithm of a number to a specified 

base 

LOG10 =LOG10(number) Returns the base-10 logarithm of a number 

MULTINOMIAL =MULTINOMIAL(num

ber1,number2,…) 

Returns the multinomial of a set of numbers 

SIN =SIN(number) Returns the sine of the given angle 

SINH =SINH(number) Returns the hyperbolic sine of a number 

SUMX2MY2 =SUMX2MY2(array_x,

array_y) 

Returns the sum of the difference of squares of 

corresponding values in two arrays 

SUMX2PY2 =SUMX2PY2(array_x,a

rray_y) 

Returns the sum of the sum of squares of 

corresponding values in two arrays 

SUMXMY2 =SUMXMY2(array_x,a

rray_y) 

Returns the sum of squares of differences of 

corresponding values in two arrays 

TAN =TAN(number) Returns the tangent of a number 

TANH =TANH(number) Returns the hyperbolic tangent of a number 

ACOS =ACOS(number) Returns the arccosine of a number 

ACOSH =ACOSH(number) Returns the inverse hyperbolic cosine of a number 

ASIN =ASIN(number) Returns the arcsine of a number 

ASINH =ASINH(number) Returns the inverse hyperbolic sine of a number 

ATAN =ATAN(number) Returns the arctangent of a number 



ATAN2 =ATAN2(x_num,y_nu

m) 

Returns the arctangent from x- and y-coordinates 

ATANH =ATANH(number) Returns the inverse hyperbolic tangent of a 

number 

DEGREES =DEGREES(angle) Converts radians to degrees 

MDETERM =MDETERM(array) Returns the matrix determinant of an array 

MINVERSE =MINVERSE(array) Returns the matrix inverse of an array 

MMULT =MMULT(array1,array

2) 

Returns the matrix product of two arrays 

RADIANS =RADIANS(angle) Converts degrees to radians 

ROMAN =ROMAN(number,for

m) 

Converts an arabic numeral to roman, as text 

SQRTPI =SQRTPI(number) Returns the square root of (number * pi) 

 Statistical Excel Formulas & Functions 

Functions Excel Formulas Description 

AVERAGE =AVERAGE(number1,

number2,…) 

Returns the average of its arguments 

AVERAGEIF =AVERAGEIF(range,cri

teria,[average_range]) 

Returns the average (arithmetic mean) of all the 

cells in a range that meet a given criteria 

COUNT =COUNT(value1,value

2,…) 

Counts how many numbers are in the list of 

arguments 

COUNTA =COUNTA(value1,valu

e2,…) 

Counts how many values are in the list of 

arguments 



COUNTBLANK =COUNTBLANK(range) Counts the number of blank cells within a range 

COUNTIF =COUNTIF(range,crite

ria) 

Counts the number of cells within a range that 

meet the given criteria 

COUNTIFS =COUNTIFS(criteria_r

ange,criteria,…) 

Counts the number of cells within a range that 

meet multiple criteria 

MAX =MAX(number1,numb

er2,…) 

Returns the maximum value in a list of arguments 

MEDIAN =MEDIAN(number1,n

umber2,…) 

Returns the median of the given numbers 

MIN =MIN(number1,numb

er2,…) 

Returns the minimum value in a list of arguments 

TEXT =TEXT(value,format_t

ext) 

Formats a number and converts it to text 

AVERAGEA =AVERAGEA(value1,va

lue2,…) 

Returns the average of its arguments, including 

numbers, text, and logical values 

AVERAGEIFS =AVERAGEIFS(average

_range,criteria_range,

criteria,…) 

Returns the average (arithmetic mean) of all cells 

that meet multiple criteria 

GEOMEAN =GEOMEAN(number1,

number2,…) 

Returns the geometric mean 

INTERCEPT =INTERCEPT(known_y

’s,known_x’s) 

Returns the intercept of the linear regression line 

LARGE =LARGE(array,k) Returns the k-th largest value in a data set 

LINEST =LINEST(known_y’s,kn

own_x’s,const,stats) 

Returns the parameters of a linear trend 



LOGEST =LOGEST(known_y’s,k

nown_x’s,const,stats) 

Returns the parameters of an exponential trend 

MAXA =MAXA(value1,value2

,…) 

Returns the maximum value in a list of arguments, 

including numbers, text, and logical values 

MINA =MINA(value1,value2,

…) 

Returns the smallest value in a list of arguments, 

including numbers, text, and logical values 

MODE.MULT =MODE.MULT(numbe

r1,number2,…) 

Returns a vertical array of the most frequently 

occurring, or repetitive values in an array or range 

of data 

MODE.SNGL =MODE.SNGL(number

1,number2,…) 

Returns the most common value in a data set 

PROB =PROB(x_range,prob_

range,lower_limit,upp

er_limit) 

Returns the probability that values in a range are 

between two limits 

RANK.AVG =RANK.AVG(number,r

ef,order) 

Returns the rank of a number in a list of numbers 

RANK.EQ =RANK.EQ(number,ref

,order) 

Returns the rank of a number in a list of numbers 

SKEW =SKEW(number1,num

ber2,…) 

Returns the skewness of a distribution 

SLOPE =SLOPE(known_y’s,kn

own_x’s) 

Returns the slope of the linear regression line 

SMALL =SMALL(array,k) Returns the k-th smallest value in a data set 

STANDARDIZE =STANDARDIZE(x,mea

n,standard_dev) 

Returns a normalized value 

TREND =TREND(known_y’s,k

nown_x’s,new_x’s,co

nst) 

Returns values along a linear trend 



NORM.S.INV =NORM.S.INV(probabi

lity) 

Returns the inverse of the standard normal 

cumulative distribution 

AVEDEV =AVEDEV(number1,nu

mber2,…) 

Returns the average of the absolute deviations of 

data points from their mean 

BETA.DIST =BETA.DIST(x,alpha,b

eta,cumulative,A,B) 

Returns the beta cumulative distribution function 

BETA.INV =BETA.INV(probability

,alpha,beta,A,B) 

Returns the inverse of the cumulative distribution 

function for a specified beta distribution 

BINOM.DIST =BINOM.DIST(number

_s,trials,probability_s,

cumulative) 

Returns the individual term binomial distribution 

probability 

BINOM.INV =BINOM.INV(trials,pr

obability_s,alpha) 

Returns the smallest value for which the 

cumulative binomial distribution is less than or 

equal to a criterion value 

CHISQ.DIST =CHISQ.DIST(x,deg_fr

eedom,cumulative) 

Returns the cumulative beta probability density 

function 

CHISQ.DIST.RT =CHISQ.DIST.RT(x,deg

_freedom) 

Returns the one-tailed probability of the chi-

squared distribution 

CHISQ.INV =CHISQ.INV(probabilit

y,deg_freedom) 

Returns the cumulative beta probability density 

function 

CHISQ.INV.RT =CHISQ.INV.RT(proba

bility,deg_freedom) 

Returns the inverse of the one-tailed probability of 

the chi-squared distribution 

CHISQ.TEST =CHISQ.TEST(actual_r

ange,expected_range) 

Returns the test for independence 

CONFIDENCE.N

ORM 

=CONFIDENCE.NORM(

alpha,standard_dev,si

ze) 

Returns the confidence interval for a population 

mean 



CONFIDENCE.T =CONFIDENCE.T(alpha

,standard_dev,size) 

Returns the confidence interval for a population 

mean, using a Student’s t distribution 

CORREL =CORREL(array1,array

2) 

Returns the correlation coefficient between two 

data sets 

COVARIANCE.P =COVARIANCE.P(array

1,array2) 

Returns covariance, the average of the products of 

paired deviations 

COVARIANCE.S =COVARIANCE.S(array

1,array2) 

Returns the sample covariance, the average of the 

products deviations for each data point pair in two 

data sets 

DEVSQ =DEVSQ(number1,nu

mber2,…) 

Returns the sum of squares of deviations 

EXPON.DIST =EXPON.DIST(x,lambd

a,cumulative) 

Returns the exponential distribution 

F.DIST =F.DIST(x,deg_freedo

m1,deg_freedom2,cu

mulative) 

Returns the F probability distribution 

F.DIST.RT =F.DIST.RT(x,deg_free

dom1,deg_freedom2) 

Returns the F probability distribution 

F.INV =F.INV(probability,deg

_freedom1,deg_freed

om2) 

Returns the inverse of the F probability distribution 

F.INV.RT =F.INV.RT(probability,

deg_freedom1,deg_fr

eedom2) 

Returns the inverse of the F probability distribution 

F.TEST =F.TEST(array1,array2

) 

Returns the result of an F-test 

FISHER =FISHER(x) Returns the Fisher transformation 

FISHERINV =FISHERINV(y) Returns the inverse of the Fisher transformation 



FREQUENCY =FREQUENCY(data_ar

ray,bins_array) 

Returns a frequency distribution as a vertical array 

GAMMA.DIST =GAMMA.DIST(x,alph

a,beta,cumulative) 

Returns the gamma distribution 

GAMMA.INV =GAMMA.INV(probab

ility,alpha,beta) 

Returns the inverse of the gamma cumulative 

distribution 

GAMMALN =GAMMALN(x) Returns the natural logarithm of the gamma 

function, G(x) 

GAMMALN.PR

ECISE 

=GAMMALN.PRECISE(

x) 

Returns the natural logarithm of the gamma 

function, G(x) 

GROWTH =GROWTH(known_y’s

,known_x’s,new_x’s,c

onst) 

Returns values along an exponential trend 

HARMEAN =HARMEAN(number1,

number2,…) 

Returns the harmonic mean 

HYPGEOM.DIS

T 

=HYPGEOM.DIST(sam

ple_s,number_sample

,population_s,number

_pop,cumulative) 

Returns the hypergeometric distribution 

KURT =KURT(number1,num

ber2,…) 

Returns the kurtosis of a data set 

LOGNORM.DIS

T 

=LOGNORM.DIST(x,m

ean,standard_dev,cu

mulative) 

Returns the cumulative lognormal distribution 

LOGNORM.INV =LOGNORM.INV(prob

ability,mean,standard

_dev) 

Returns the inverse of the lognormal cumulative 

distribution 



NEGBINOM.DI

ST 

=NEGBINOM.DIST(nu

mber_f,number_s,pro

bability_s,cumulative) 

Returns the negative binomial distribution 

NORM.DIST =NORM.DIST(x,mean,

standard_dev,cumula

tive) 

Returns the normal cumulative distribution 

NORM.INV =NORM.INV(probabili

ty,mean,standard_de

v) 

Returns the inverse of the normal cumulative 

distribution 

NORM.S.DIST =NORM.S.DIST(z,cum

ulative) 

Returns the standard normal cumulative 

distribution 

PEARSON =PEARSON(array1,arr

ay2) 

Returns the Pearson product moment correlation 

coefficient 

PERCENTILE.EX

C 

=PERCENTILE.EXC(arra

y,k) 

Returns the k-th percentile of values in a range, 

where k is in the range 0..1, exclusive 

PERCENTILE.IN

C 

=PERCENTILE.INC(arra

y,k) 

Returns the k-th percentile of values in a range 

PERCENTRANK.

EXC 

=PERCENTRANK.EXC(a

rray,x,significance) 

Returns the rank of a value in a data set as a 

percentage (0..1, exclusive) of the data set 

PERCENTRANK.

INC 

=PERCENTRANK.INC(a

rray,x,significance) 

Returns the percentage rank of a value in a data set 

PERMUT =PERMUT(number,nu

mber_chosen) 

Returns the number of permutations for a given 

number of objects 

POISSON.DIST =POISSON.DIST(x,mea

n,cumulative) 

Returns the Poisson distribution 

QUARTILE.EXC =QUARTILE.EXC(array,

quart) 

Returns the quartile of the data set, based on 

percentile values from 0..1, exclusive 



QUARTILE.INC =QUARTILE.INC(array,

quart) 

Returns the quartile of a data set 

RSQ =RSQ(known_y’s,kno

wn_x’s) 

Returns the square of the Pearson product 

moment correlation coefficient 

STDEV.P =STDEV.P(number1,n

umber2,…) 

Calculates standard deviation based on the entire 

population 

STDEV.S =STDEV.S(number1,n

umber2,…) 

Estimates standard deviation based on a sample 

STDEVA =STDEVA(value1,value

2,…) 

Estimates standard deviation based on a sample, 

including numbers, text, and logical values 

STDEVPA =STDEVPA(value1,val

ue2,…) 

Calculates standard deviation based on the entire 

population, including numbers, text, and logical 

values 

STEYX =STEYX(known_y’s,kn

own_x’s) 

Returns the standard error of the predicted y-value 

for each x in the regression 

T.DIST =T.DIST(x,deg_freedo

m,cumulative) 

Returns the Percentage Points (probability) for the 

Student t-distribution 

T.DIST.2T =T.DIST.2T(x,deg_free

dom) 

Returns the Percentage Points (probability) for the 

Student t-distribution 

T.DIST.RT =T.DIST.RT(x,deg_free

dom) 

Returns the Student’s t-distribution 

T.INV =T.INV(probability,de

g_freedom) 

Returns the t-value of the Student’s t-distribution 

as a function of the probability and the degrees of 

freedom 

T.INV.2T =T.INV.2T(probability,

deg_freedom) 

Returns the inverse of the Student’s t-distribution 

T.TEST =T.TEST(array1,array2

,tails,type) 

Returns the probability associated with a Student’s 

t-test 



TRIMMEAN =TRIMMEAN(array,pe

rcent) 

Returns the mean of the interior of a data set 

VAR.P =VAR.P(number1,num

ber2,…) 

Calculates variance based on the entire population 

VAR.S =VAR.S(number1,num

ber2,…) 

Estimates variance based on a sample 

VARA =VARA(value1,value2,

…) 

Estimates variance based on a sample, including 

numbers, text, and logical values 

VARPA =VARPA(value1,value

2,…) 

Calculates variance based on the entire population, 

including numbers, text, and logical values 

WEIBULL.DIST =WEIBULL.DIST(x,alph

a,beta,cumulative) 

Returns the Weibull distribution 

Z.TEST =Z.TEST(array,x,sigma

) 

Returns the one-tailed probability-value of a z-test 

 

 

 

 

Defined Names 

Name Manager - Displays the Name Manager dialog box. 

Define Name - Button with Drop-Down. The button displays the "New Name" dialog box 

. The drop-down contains the commands: Define Names and Apply Names. The Define 

Names allows you to create workbook and worksheet level named ranges and displays 

the "New Name" dialog box. The Apply Names displays the "Apply Names" dialog box. 

Use in Formula - Drop-Down. The drop-down contains a list of all the named ranges in 

the workbook (25 with scrolling) and Paste Names. The Paste Names command displays 

the "Paste Name" dialog box. 

Create from Selection - Displays the "Create Names from selection" dialog box. This 

https://bettersolutions.com/excel/named-ranges/name-manager.htm


enables you to name a selected range of cells using a row or column title that you've 

entered. 

 
 

Formula Auditing 

 

Trace Precedents - Displays arrows that indicate what cells affect the value of the 

currently selected cell. 

Trace Dependents - Displays arrows that indicate what cells are affected by the value in 

the currently selected cell. 

Remove Arrows - Button with Drop-Down. The button removes all the arrows drawn by 

the trace precedents and trace dependents. The drop-down contains the commands: 

Remove Arrows, Remove Precendent Arrows and Remove Dependent Arrows. 

Show Formulas - (Ctrl + '). Toggles the display of the formulas rather than the result. 

Error Checking - Button with Drop-Down. The button displays the "Error Checking" 

dialog box. The drop-down contains the commands: Error Checking, Trace Error and 

Circular References. The Circular References extension will only be enabled when the 

active workbook contains at least one circular reference. 

Evaluate Formula - Displays the "Evaluate Formula" dialog box. This allows you to step 

through a formula calculation. 

Watch Window - Displays the Watch Window. Allows you to view the contents of cells 

and their results as you make changes. 

 

 

Calculation 

 

Calculation Options - Drop-Down. The drop-down lets you quickly change the 

calculation setting in the active workbook between Manual, Automatic and Automatic 

https://bettersolutions.com/excel/formulas/watch-window.htm


except for Data Tables. This setting is in fact an application setting. For more information 

please refer to the Calculation page. 

Calculate Now - (F9). Provides a shortcut to the (Excel Options)(Calculation tab, "Calc 

Now"). This option no longer appears on the Excel Options dialog box. 

Calculate Sheet - (Shift + F9). Provides a shortcut to the (Excel Options)(Calculation tab, 

"Calc Sheet"). This option no longer appears on the Excel Options dialog box. 

 

 

Solutions 

This group is only displayed if you have the Euro Currency Tools add-in loaded. 

 

Euro Conversion - Launch the Euro Conversion Wizard. 

Euro Formatting - Apply Euro formatting to the selected cells. 

Quick Conversion - Perform quick conversions. 

 

 

DATA TAB 
We use Data tab for the large amount of data.It is useful to import the data by connecting 
with the server, and we can import data automatically from web, MS Access etc. And sort 
& filter are very helpful options we have in Excel; it makes easy to read vast data. 
  

 
  
Data tab contains 5 groups:- 
  

https://bettersolutions.com/excel/formulas/calculation.htm
https://bettersolutions.com/excel/add-ins/euro-currency-tools.htm
https://www.exceltip.com/wp-content/uploads/2015/08/image-12.png


 
  
a)    Get External Data: - In Excel, we can import data from MS Access, Web, Text and 
other sources. Also, we can import the data from other applications. 

 
  
b)    Connections: -It is used to display the entire data connections for the workbook. 
Data connections are links to the data outside the workbook which can be updated if the 
source data changes. And updated data can be obtained by refreshing all sources in 
workbook. 

 
  
c)    Sort & Filter: -To set the data in ascending or descending order on the basis of 
value or as per the first letter of a word, we use Sort option. Also, we can put the basic 
and advanced filter from here only. 

 
  
d)    Data Tools: -This option is very important to make the report interactive; it helps us 
to make the data authentic, and using this tab, we can restrict or validate the entries if the 
data is being updated by multiple users. Text to Columns helps us to split the single 
column into multiple columns as per data. Flash fills the values in the range. We can 
delete duplicate rows from the data by using Remove Duplicates option. We use Data 
Validation to provide the list that can be entered in cell, or we can restrict the entries, or 

https://www.exceltip.com/wp-content/uploads/2015/08/image-22.png
https://www.exceltip.com/wp-content/uploads/2015/08/image-32.png
https://www.exceltip.com/wp-content/uploads/2015/08/image-42.png
https://www.exceltip.com/wp-content/uploads/2015/08/image-52.png


we can validate the entries in the cell. We use Consolidate option to summarize data 
from separate ranges, and consolidate the result in a single output range. We use What-
if-Analysis to analyse the data. 

 
  
e)    Outline: -We use this option to make the data more analytical and understandable. 
We can make group of rows or columns or automatically create an outline. We can 
ungroup the data; quickly calculate rows of related data by inserting subtotals and totals. 
We use Show and Hide options when we want to insert the Subtotal in data. 

 

 

REVIEW TAB 

Proofing 

 

Spelling - (F7). Displays the "Spelling" dialog box. Allows you to check the spelling on the 

active worksheet. 

Research - (Removed in 2016). Toggles the display of the Research Task Pane. 

Thesaurus - Toggles the display of the Research task pane defaulting the research service 

to the thesaurus. 

 

 

Accessibility 

https://bettersolutions.com/excel/reviewing/research-task-pane.htm
https://www.exceltip.com/wp-content/uploads/2015/08/image-62.png
https://www.exceltip.com/wp-content/uploads/2015/08/image-7.png


 

Check Accessibility - (Added in 2016). Displays the Accessibility Checker Task Pane. This 

identifies any aspects of your workbook that could be altered to assist people with 

disabilities. 

 

 

Insights 

 

Smart Lookup - (Added in 2016). Displays the Smart Lookup Task Pane. This is powered 

by Bing and provides wiki articles and top related searches from the web. 

 

 

Language 

 

Translate - (Added in 2010). Toggles the display of the Research task pane defaulting the 

research service to the translation. 

 

 

Comments 

https://bettersolutions.com/excel/workbooks/accessibility-checker-task-pane.htm
https://bettersolutions.com/excel/workbooks/smart-lookup-task-pane.htm


 

New Comment / Edit Comment - (Shift + F2). Inserts a comment at the active cell. 

Delete - Deletes the selected comment. 

Previous Comment - Moves to the previous comment in the active workbook. 

Next Comment - Moves to the next comment in the active workbook. 

Show Comments - Toggles the display of the Comments task pane. 

Show/Hide Comment - (Removed in 2019). Toggles the display of the comment in the 

active cell. 

Show All Comments - (Removed in 2019). Toggles the display of comments in the active 

workbook (all worksheets). 

Show Ink - (Removed in 2019). Show or hide ink in the active workbook. This is tablet 

specific. 

 

 

Notes 

 

Notes - (Added in 2019). Drop-Down. The drop-down contains the commands: New 

Note, Previous Note, Next Note, Show/Hide Note, Show All Notes and Convert to 

Comments. 

 

 

Changes 

In 2019 this group was removed. 

Protect and Share Workbook - (Removed in 2019). Displays the "Protect Shared 

Workbook" dialog box. 

Track Changes - (Removed in 2019). Drop-Down. The drop-down contains the 

commands: Highlight Changes and Accept/Reject Changes. 



 

 

Protect 

 

Protect Sheet - Displays the "Protect Sheet" dialog box. 

Protect Workbook - The drop-down displays the following commands: Protect Structure 

and Windows as well other Restrict Permission options. These can only be used if you 

have IRM [link] installed. 

Allow Edit Ranges - Allows specific users to edit certain ranges in a workbook or sheet. 

Before using this option you need to define your security settings using the Protect Sheet 

command. This command is disabled when the worksheet is protected. 

Unshare Workbook - This is disabled by default. If you open a workbook that is currently 

being shared using the legacy "Share Workbook" feature this button will become 

enabled, allowing you to unshare the workbook. Shared workbooks have been replaced 

with Co-Authoring. Press the 'Share' button in the top right corner to display the Share 

Task Pane. Workbooks must be saved to an online location. 

Share Workbook - (Removed in 2019) (Added in 2016). Allows multiple users to work in 

a workbook at the same time. The workbook should be saved to a shared drive. 

Workbooks containing tables cannot be shared. Displays the "Share Workbook" dialog 

box. 

 

 

Ink 

 

Hide Ink - Drop-Down. The drop-down contains the commands: Hide Ink, Delete All Ink 

on Sheet and Delete All Ink on Workbook. 

https://bettersolutions.com/excel/track-changes/co-authoring.htm
https://bettersolutions.com/excel/track-changes/share-task-pane.htm
https://bettersolutions.com/excel/track-changes/share-task-pane.htm


 

 

VIEW TAB 
The commands for hiding and showing worksheets are on the Home Tab under (Format 

> Unhide). 

The commands for hiding and showing workbooks (and windows) can be found on this 

tab. 

 

 

Sheet View 

Lets you create different views of the same worksheet when you are collaborating with 

others. 

Only enabled in Excel online or on the Desktop when your workbook has been saved in 

OneDrive. 

Switch Sheet View - 

Keep - 

Exit - 

New - 

Options - Displays sheet view options. 

 

 

Workbook Views 

 

Normal - Displays the worksheet in the normal view. There is also a shortcut to this view 

in the bottom right corner of the status bar. 

Page Break Preview - (Moved in 2013). Used for adjusting page breaks. There is also a 

shortcut to this view in the bottom right corner of the status bar. 

Page Layout - Displays the worksheet as it will appear on a printed page.Displays a very 

https://bettersolutions.com/excel/ribbon/home-tab.htm


useful horizontal and vertical ruler plus you can add/change headers and footers, check 

margins, row/column headings and scaling options. Not to be confused with Print 

Preview. There is also a shortcut to this view in the bottom right corner of the status bar. 

Custom Views - Displays the "Custom Views" dialog box. 

Full Screen - (Removed in 2013). Displays the workbook in full screen mode. Press Esc to 

return to the normal screen. 

 

 

Show 

 

Ruler - Toggles the display of the horizontal and vertical rulers. This is only available 

when you are in Page Layout view. You can change the units displayed from the (Excel 

Options, Advanced tab)(Display, Ruler Units). By default the ruler displays the default 

units that are specified in the control panel, regional settings. These units can be either 

inches, centimeters or millimeters. 

Gridlines - Toggles the display of gridlines on the active worksheet. Provides a shortcut 

to (Excel Options, Advanced tab)(Display options for this worksheet, show gridlines). 

Formula Bar - Toggles the display of the formula bar. Provides a shortcut to (Excel 

Options)(Advanced tab, Show formula bar). 

Headings - Toggles the display of the heading rows. Provides a shortcut to (Excel 

Options)(Advanced tab, Show row and column headers). 

 

 

Zoom 

 



Zoom - Displays the "Zoom" dialog box. 

100% - Zoom the workbook to 100% of its normal size. 

Zoom to Selection - Zoom the worksheet to display just the currently selected cells. 

 

 

Window 

 

New Window - Creates a new window of your current workbook. 

Arrange All - Tile all open windows side by side on the screen. 

Freeze Panes - Drop-Down. The drop-down contains the commands: Freeze Panes, 

Freeze Top Row and Freeze First Column. 

Split - Splits the window into multiple resizeable panes which allow you to have multiple 

views of the same workbook. 

Hide - Hides the current workbook or window. 

Unhide - Displays the "Unhide" dialog box allowing you to unhide a workbook or 

window. 

View Side by Side - View two workbooks side by side to allow you to compare their 

contents. 

Synchronous Scrolling - Synchronize the scrolling of two windows so they scroll 

together. The View Side by Side option must be switched on for this command to be 

enabled. 

Reset Window Position - Reset the window position of the two windows being 

compared so that they share the screen equally. The View Side by Side option must be 

switched on for this command to be enabled. 

Save Workspace - (Removed in 2013). Displays the "Save Workspace" dialog box. This 

allows you to save the layout of all the workbooks that are currently open so this layout 

can be reopened at a later date. 

Switch Windows - Drop-Down. The drop-down contains a list of all the 

workbooks/windows that are currently open. 

 

 

Macros 



 

Macros - Button with Drop-Down. The button is a shortcut to View Macros which 

displays the "Macro" dialog box displaying all the available macros. The drop-down 

contains the commands: View Macros, Record Macro and Use Relative References. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



MS-POWER POINT 

PowerPoint 2013's tri-paned interface has three regions: the Slides Pane, the Slide 
Area, and the Notes Pane. The Notes Pane is placed right below the Slide area, as 
shown highlighted in red within Figure 1. The Notes Pane provides space to add 
speaker's notes that can be so helpful to the presenter while presenting - you can 
also write any sort of information about the presentation or individual slide. 

By default, the Notes Pane may be completely empty -- you may also see some 
boilerplate text such as "Click to add notes", as shown in  

 
 

To add your notes in this area, you typically just insert your cursor on the 
boilerplate text and start typing -- we explain this in more detail within the next 
section. 

What's important to realize is that each slide in your presentation has its own 
notes. When you navigate to another slide, you will have to add more notes 
relevant to the active slide. 



FILE TAB 
 

 

The File Tab in PowerPoint 2013S is some of the most important tabs in 
PowerPoint. Some of the important actions are listed in File Tab like Sharing, 
Saving, Protecting, Save & Save As and more. 
If you click on the other tabs like Home Tab or Insert Tab, just the ribbon will 
change, but when you click on the File Tab in PowerPoint 2016, the complete 
Interface will change. In the File tab, there are many different actions for the 
presentation like you can save, export, share, print or add a new presentation. 
The file tab also provides info about your presentation If that is completed or 
not. File Tab in PowerPoint 2016 is divided into many branches. I will give some 
short information about each of them in this post. 

File Tab in PowerPoint 2013 

1. Info 

You can manage File data setting, protect your presentation, give a password, 
restrict access to the presentation. 
If you have many accounts, so it will provide information that when and which 



presentation was opened and edited. Also, show last time when you worked 
with PowerPoint. 

 

Information about presentation 

2. New 

You can open new templates that you want or a blank page. You can search for 
online templates if you have an internet connection. You also can use the filter 
templates that are below the search bar. If the blank page is needed, go to 
insert tab and click on the (Blank Page). 

http://www.wikigain.com/wp-content/uploads/2016/04/File-Tab-Info.png


 

Add new template or blank page 

3. Open 

In this option, there are many options that you can open presentation from 
there as well. 
Recent: The recent presentation that you have opened are listed on the right 
side, and you can click and open the presentation that you need. 
One Drive: You can insert presentation from any device that has One Drive app. 
This PC: If you have any presentation and that is not in the recent files, you can 
browse and open that presentation. You can browse through the (documents) 
folder on your PC. 
Browse: It is the fourth way that you can open a file or a presentation. Simply 
just browse and find the presentation and click “Open” to open. 
If you’re interested in opening document in Word 2013 visit 

 

http://www.wikigain.com/wp-content/uploads/2016/04/file-tabnew.png
http://www.wikigain.com/wp-content/uploads/2016/04/file-tabopen.png


Open file or presentation 

4. Save & Save as 

Save and Save As are similar to each other, If you have saved the presentation 
before by any other name then the second time if you want to save you have to 
click on Save As. If you have not saved the presentation before so you can click 
on the Save option. Save as mean you can save it as a PDF, XPS document, and 
many more types. 

 

Save & Save As 

5. Print 

You can print the presentation that you have made. It is very easy just select the 
correct options. 
First, select how many copies you want to copy then select your printer. 
After that select the page if it should be landscape or portrait, grayscale or 
colored and then click on the print button. The Printing option in PowerPoint 
2016 and 2013 are same. 

http://www.wikigain.com/wp-content/uploads/2016/04/file-tabsavesave-as.png


 

Print any presentation 

6. Share 

The presentation can be shared with two computers If that are linked. You can 
share presentations via Email and publish the slide directly If you have a 
website. You can present a presentation online on a website for that you need 
to have a Microsoft account. 

 Working with File tab in MS Word 2016 (Share, Export and Close) 

http://www.wikigain.com/wp-content/uploads/2016/04/file-tabprint.png


 

Sharing in PowerPoint 2013 

7. Close 

Close the slides and all content from the presentation you have opened. 

 

HOME TAB 
The Home Tab is used to perform many of the common tasks such as changing 

fonts, cutting and pasting text and images into presentations, changing paragraph 

formats, drawing objects, and editing text. The groups and buttons for this ribbon 

are described in the table below. 

Clipboard Group  

Paste This button is used to insert items into a document that have been stored on 

the clipboard.  

Cut To remove text or other items from a document and store it on the clipboard, 

click this button.  

Copy Click this button to make a copy of selected text or other items in a 

presentation and store it on the clipboard.  

Format Painter To make a copy of selected text and then apply the formatting to 

other text in a slide, click this button. A single click will apply the formatting to 

other selected text one time. To apply the formatting to other selected text several 

times, double-click the format painter button. When all the formatting has been 

applied, click the button again to deactivate the format painter.  

http://www.wikigain.com/wp-content/uploads/2016/04/File-tabshare-1.png


Clipboard Task Pane Launcher This button is located in the lower right corner of 

the Clipboard group. It is used to open the Clipboard Task Pane. This is the task 

pane that will display when items that are added to the clipboard are displayed. 

This allows more than one item to be added to the clipboard before the items are 

pasted into the document.  

Slides Group  

New Slide Click this button to insert a new slide into the presentation. The slide 

will be inserted after the current slide with the same format as the current slide. 

Clicking the arrow will display a gallery of different slide layouts. Click any of the 

slide layouts to insert a new slide into the presentation.  

Layout When this button is clicked, a gallery of different slide layouts will appear. 

Click one of the layouts to apply it to the current slide; the slide where the 

insertion point is located.  

Reset This button is used to reset the slide position, size, and formatting to its 

default value.  

Section Use this button to organize the slides in a presentation into sections.  

Font Group  

Font Type To select the type of font for a whole document or for selected text 

within the document, click this button.  

Font Size This button is used to change the size of the font for the whole document 

or for selected text within the document.  

Increase Font Size Click this button to increase the size of the font for selected 

text. Each time the button is clicked, the font size will increase by one or two point 

sizes.  

Decrease Font Size To decrease the size of selected text, click this button. The size 

of the font will decrease by one or two point sizes each time the button is clicked.  

Clear All Formatting To clear all the formatting that has been applied to selected 

text, click this button.  

Bold Click this button to bold selected text in a document. This is a toggle button. 

When the button is clicked the second time the bold formatting will be removed.  



Italics This button is used to italicize selected text in a document. This is a toggle 

button. When the button is clicked the second time the italics will be removed 

from the selected text.  

Underline To underline selected text in a document, click this button. This is a 

toggle button. When the button is clicked the second time the underline 

formatting will be removed.  

Text Shadow Use this button to apply a shadow behind the selected text to help it 

stand out on the slide. Click the button a second time to remove the shadow from 

the selected text.  

Strikethrough This button is used to draw a line through selected text in a 

document. To remove the strikethrough, click the button a second time.  

Character Spacing Click this button to change the spacing between characters. A 

list of spacing options will appear.  

Change Case To change the selected text to UPPERCASE, lowercase, or other 

common capitalizations, click this button. A list of possible capitalizations will 

appear.  

Font Color This button is used to change the color of the font for the selected text. 

When the button is clicked, a gallery of theme and standard colors will appear.  

Font Dialog Box Launcher This button is located in the lower right corner of the 

Font group. It is used to launch the Font dialog box where additional changes can 

be made to the Font.  

Paragraph Group  

Bullets To create a bulleted list within a slide, click this button. Click the list arrow 

to display a gallery of bullet styles.  

Numbering This button is used to create a numbered list within a slide. When the 

list arrow is clicked, a gallery of number styles will display.  

Decrease List Level When an indent has been applied to text in a slide, this button 

is used to decrease the indent. Click the button to decrease each level of the 

indent.  

Increase List Level Click this button to increase the indent for a paragraph, 

numbered list, bulleted list, or a multilevel list. Each time the button is clicked, the 

indent will increase one level.  



Line Spacing This button is used to specify the amount of space between lines of 

text. When the button is clicked, a list of possible line spacing options will appear.  

Align Left Click this button to align all the text in a document or paragraph at the 

left margin. The text at the left margin will be even. The text in the right margin will 

be uneven. This is the default alignment for all presentations created in 

PowerPoint.  

Center To center selected text or a paragraph in a document, click this button.  

Align Right This button is used to align text in a slide at the right margin. The text 

at the right margin will be even. The text on the left side will be uneven.  

Justify When this button is clicked, the text in a slide will be aligned evenly at both 

the left and right margin. Additional spacing will be inserted between words as 

necessary.  

Add/Remove Column Click this button to split the text in the slide to two or more 

columns.  

Text Direction To change the orientation of text to vertical or stacked, click this 

button. It is also possible to rotate the text using this button.  

Align Text This button is used to specify how text is aligned vertically in the text 

box. The default options are top, bottom, and middle.  

Insert Smart Art Graphic When this button is clicked, the selected bullet items are 

converted to a Smart Art graphic. There are several different styles to choose from.  

Paragraph Dialog Box Launcher This button is located in the lower right corner of 

the Paragraph Group. It is used to open the Paragraph Dialog Box where additional 

Paragraph formatting options are available.  

Drawing Group  

Shapes Gallery Click the arrow next to this button and then select an item in the 

gallery to insert different shapes such as rectangles, triangles, and circles into a 

slide. When the button is clicked, a gallery of different shapes will appear.  

Arrange To arrange objects on the slide by changing the order, position, and 

rotation click this button. A list of different options will appear when the button is 

clicked.  

Quick Styles Use this button to apply a visual style to the shape or text. A gallery of 

different styles will appear when the button is clicked.  



Shape Fill This button is used to change the fill color for the selected shape. A 

gallery of different colors and formatting options will appear when the button is 

clicked.  

Shape Outline When this button is clicked, a gallery of different outline colors and 

options that can be applied to the selected shape will appear.  

Shape Effects To apply shadows or other effects to a shape, click this button. A list 

of different categories of effects will appear. Move the mouse pointer over any of 

the effects to see a gallery of effects for each category.  

Format Shape Task Pane Launcher This button appears in the lower right corner of 

the Drawing group. It is used to launch the Format Shape Dialog Box.  

Editing Group  

Find To locate a particular word or phrase within a presentation, click this button. 

The Find dialog box will display. Within this box, the word or phrase that is to be 

found can be specified.  

Replace This feature is used to locate text within a presentation and replace it with 

other text. When the button is clicked, the Replace dialog box will display. This is 

where the word(s) to be found and replaced are specified. Select Click this button 

to select text or objects within a presentation. The options are to select all the 

objects in the active slide, select objects within the presentation, or to open the 

Selection Task Pane. 

 

 

INSERT TAB 
The Insert Tab is used to insert different features such as tables, pictures, clip art, 

shapes, charts, page numbers, word art, or headers, and footers into a 

presentation. The table below describes each of the groups and buttons available 

on this tab.  

Slides Group  

New Slide This button is used to insert a new slide into the presentation. The slide 

will be inserted after the one where the insertion point is located. To insert a slide 

with a different layout, click the arrow at the bottom of the button.  

Tables Group  



Tables This button is used to insert a table into a slide. A list will appear with a grid 

that can be used to create the table. Additional options for creating a table, such as 

drawing a table, are also listed.  

Images Group  

Pictures To insert a picture from a file into the document, click this button. The 

Insert Picture dialog box will appear. This dialog box is used to select the picture.  

Online Pictures Click this button to insert an image from Bing Image Search or 

OneDrive.  

Screenshot This button is used to insert a picture of any program that is not 

minimized to the Task Bar. To insert any part of the screen, click the Screen 

Clipping link.  

Photo Album To create a presentation based on a set of pictures, click this button. 

Options can be set for how the pictures display on the slide. Also, captions may be 

added to each picture.  

Illustrations Group  

Shapes This button is used to insert different shapes into a slide. A gallery of 

different kinds of shapes will appear when the button is clicked. To insert a shape, 

click the desired shape and then draw the shape in the slide.  

Smart Art To insert a Smart Art graphic into a slide, click this button. Smart Art 

graphics are objects such as Venn diagrams and organizational charts. When the 

button is clicked, a gallery of different categories and shapes will be displayed. 

Chart Click this button to display the Insert Chart dialog box. This will display a 

gallery of different types of charts that can be created in a Word document.  

Add-Ins Group  

Store These features allows you to find add-ins at the Office Store.  

My Add-Ins With this feature you can select an add-in that will enhance your work.  

Links Group  

Hyperlink To insert a link to items such as a Web page, another document, or an 

email address, click this button. The Hyperlink dialog box will display where the link 

can be specified. It is also possible to create a new document, worksheet, or 

presentation while creating a link to the item.  



Action When some type of actions such as creating a hyperlink to an object or 

inserting a sound is to be specified, click this button. The Action Settings dialog box 

will appear. In this dialog box, it is possible to create hyperlinks to other files, other 

PowerPoint presentations, to the first or last slide in the presentation, or too many 

other areas. It is also possible to apply a sound to the selected object.  

Comments Group  

Comments Use this feature to add a note about a portion of the presentation. This 

is a good feature to use when working with others on a presentation.  

Text Group  

Text Box Text boxes are used to highlight text within a presentation. Click this 

button to display a gallery of different types of text boxes. Move the mouse pointer 

over the items for a description of each style.  

Header & Footer This button is used to insert a header or footer into the 

presentation or for handouts. When the button is clicked, the header and footer 

dialog box will display.  

WordArt Use this button to insert decorative text into a slide. When the button is 

clicked, a gallery of Word Art styles will be displayed. Click one of the styles to 

apply it to the slide.  

Date and Time To insert the date and time into the current presentation, click this 

button. The Header and Footer dialog box will display. This dialog box is used to 

insert the Date and Time into the presentation.  

Slide Number Click this button to insert the slide number into the slide. The slide 

number reflects the position of the slide within the presentation.  

Object Use this button to insert an object such as an Excel Worksheet or an Excel 

Chart into the presentation.  

Symbols Group  

Equation To insert common mathematical equations into a slide, click this button. 

It is also possible to build equations using a gallery of math symbols.  

Symbol This button is used to insert symbols that are not on the keyboard into the 

document. These include copyright symbols, trademark symbols, and paragraph 

marks, plus many others.  

Media Group  



Video This button is used to insert a video clip into a presentation slide. Videos can 

be inserted from the Web, Facebook, or from a file that is stored in a folder on the 

computer.  

Audio To insert a sound or recording into a presentation, click this button. Sound 

can be inserted from Office.com, or a file on the computer.  

Screen Recording This feature can be used to record the computer screen and 

related audio before inserting the recording onto a slide. 

 

 

 

 

DESIGN TAB 
This tab is used to apply a design to a PowerPoint presentation. It is also possible to 

make changes to the slide size, slide background, and other design attributes. The 

table below provides a listing of the groups and buttons on this ribbon. A 

description of each of the buttons is also provided.  

 

Themes Group  

Theme Designs Move the mouse pointer over each of the designs to see a Live 

Preview. Click the design to apply it to the presentation. To access additional 

themes, click the arrows at the end of the Styles Gallery. To display all the designs, 

click the more button in the lower right corner of the gallery.  

Variants Group  

Variants Gallery Once a theme has been chosen for a presentation this area is used 

to select different colors, fonts, and effects for the theme. It is also possible to 

change the background styles.  

Colors This option is used to change the colors for the selected theme. To access 

this option, click the More button in the lower right corner of the Variants Gallery. 

When the option is selected, a list of different theme colors will appear.  

Fonts When this option is selected, a list of available theme fonts will be displayed. 

To access this option, click the More button in the Variants Gallery. Effects These 



are sets of lines and fill effects that can be applied to a theme in a presentation. 

When the button is clicked, a gallery of these different effects will display.  

Background Styles When the background for a slide needs to be changed, click this 

button. A gallery of different backgrounds will display. Click the Format Background 

link to open the Format Background Task Pane.  

Customize Group  

Slide Size To change the slide from Standard to Widescreen, click this button. 

Select Custom Slide Size to make additional size changes, such as Portrait or 

Landscape.  

Format Background Use this button to open the Format Background Task Pane. 

This task pane is used to add background pictures to a slide or to apply other 

formatting features to the design of a presentation. 

 

Transition tab 
If you've ever seen a PowerPoint presentation that had special effects between 

each slide, you've seen slide transitions. A transition can be as simple as fading to 

the next slide or as flashy as an eye-catching effect. PowerPoint makes it easy to 

apply transitions to some or all of your slides, giving your presentation a polished, 

professional look 

 

About transitions 

There are three categories of unique transitions to choose from, all of which can 

be found on the Transitions tab: 

 Subtle: These are the most basic types of transitions. They use simple 
animations to move between slides. 



 

 Exciting: These use more complex animations to transition between 
slides. While they're more visually interesting than Subtle transitions, 
adding too many can make your presentation look less professional. 
However, when used in moderation they can add an nice touch 
between important slides. 

 

 Dynamic Content: If you're transitioning between two slides that use 
similar slide layouts, dynamic transitions will move only 
the placeholders, not the slides themselves. When used correctly, 
dynamic transitions can help unify your slides and add a further level 
of polish to your presentation. 

 

To apply a transition: 

1. Select the desired slide from the Slide Navigation pane. This is the 
slide that will appear after the transition. 



 

2. Click the Transitions tab, then locate the Transition to This 
Slide group. By default, None is applied to each slide. 

3. Click the More drop-down arrow to display all transitions. 

 

4. Click a transition to apply it to the selected slide. This will 
automatically preview the transition. 



 

You can use the Apply To All command in the Timing group to apply the same 

transition to all slides in your presentation. Keep in mind that this will modify any 

other transitions you've applied. 

 

Try applying a few different types of transitions to various slides in your 

presentation. You may find that some transitions work better than others, 

depending on the content of your slides. 

To preview a transition: 

You can preview the transition for a selected slide at any time using either of these 

two methods: 



 Click the Preview command on the Transitions tab. 

 

 Click the Play Animations command in the Slide Navigation pane. 

 

Modifying transitions 

To modify the transition effect: 

You can quickly customize the look of a transition by changing its direction. 

1. Select the slide with the transition you want to modify. 

2. Click the Effect Options command, and choose the desired option. 
These options will vary depending on the selected transition. 



 

3. The transition will be modified, and a preview of the transition will 
appear. 

Some transitions do not allow you to modify the direction. 

To modify the transition duration: 

1. Select the slide with the transition you want to modify. 

2. In the Duration field in the Timing group, enter the desired time for 
the transition. In this example, we'll increase the time to two 
seconds—or 02.00—to make the transition slower. 

 

To add sound: 

1. Select the slide with the transition you want to modify. 

2. Click the Sound drop-down menu in the Timing group. 

3. Click a sound to apply it to the selected slide, then preview the 
transition to hear the sound. 



 

Sounds are best used in moderation. Applying a sound between every slide could 

become overwhelming or even annoying to an audience when presenting your 

slide show. 

To remove a transition: 

1. Select the slide with the transition you want to remove. 

2. Choose None from the Transition to This Slide group. The transition 
will be removed. 

 

To remove transitions from all slides, apply the None transition to a slide, then 

click the Apply to All command. 



Advancing slides 

Normally, in Slide Show view you would advance to the next slide by clicking your 

mouse or by pressing the spacebar or arrow keys on your keyboard. The Advance 

Slides settings in the Timing group allows the presentation to advance on its 

own and display each slide for a specific amount of time. This feature is especially 

useful for unattended presentations, such as those at a trade show booth. 

To advance slides automatically: 

1. Select the slide you want to modify. 

2. Locate the Timing group on the Transitions tab. Under Advance Slide, 
uncheck the box next to On Mouse Click. 

3. In the After field, enter the amount of time you want to display the 
slide. In this example, we will advance the slide automatically after 1 
minute and 15 seconds, or 01:15:00. 

 

4. Select another slide and repeat the process until all the slides have the 
desired timing. You can also click the Apply to All command to apply 
the same timing to all slides. 

Animation tab 
In PowerPoint, you can animate text and objects such as clip art, shapes, and 

pictures. Animation—or movement—on the slide can be used 

to draw the audience's attention to specific content or to make the slide easier to 

read. 

The four types of animations 

There are several animation effects you can choose from, and they are organized 

into four types: 



 Entrance: These control how the object enters the slide. For example, 
with the Bounce animation the object will "fall" onto the slide and 
then bounce several times. 

 

 Emphasis: These animations occur while the object is on the slide, 
often triggered by a mouse click. For example, you can set an object 
to spin when you click the mouse. 

 

 Exit: These control how the object exits the slide. For example, with 
the Fade animation the object will simply fade away. 

 

 Motion Paths: These are similar to Emphasis effects, except the 
object moves within the slide along a predetermined path, like 
a circle. 

 

To apply an animation to an object: 

1. Select the object you want to animate. 

2. On the Animations tab, click the More drop-down arrow in 
the Animation group. 



 

3. A drop-down menu of animation effects will appear. Select the 
desired effect. 

 

4. The effect will apply to the object. The object will have a 
small number next to it to show that it has an animation. In the Slide 
pane, a star symbol also will appear next to the slide. 



 

At the bottom of the menu, you can access even more effects. 

 

Effect options 

Some effects will have options you can change. For example, with the Fly In effect 

you can control which direction the object comes from. These options can be 

accessed from the Effect Options command in the Animation group. 



 

To remove an animation 

1. Select the small number located next to the animated object. 

 

2. Press the Delete key. The animation will be deleted. 

Working with animations 

To add multiple animations to an object: 

If you select a new animation from the the menu in the Animation group, it 

will replace the object's current animation. However, you'll sometimes want to 

place more than one animation on an object, like an Entrance and an Exit effect. 

To do this, you'll need to use the Add Animation command, which will allow you to 

keep your current animations while adding new ones. 

1. Select an object. 



2. Click the Animations tab. 

3. In the Advanced Animation group, click the Add Animation command 
to view the available animations. 

4. Select the desired animation effect. 

 

5. If the object has more than one effect, it will have a 
different number for each effect. The numbers indicate the order in 
which the effects will occur. 

 

To copy animations with the Animation Painter: 

In some cases, you may want to apply the same effects to more than one object. 

You can do this by copying the effects from one object to another using 

the Animation Painter. In our example, we want text to appear on our banner 

shape, so we've added a text box on top of the banner. We'd like the text to 



appear using the same effects we used on the banner, so we'll use the Animation 

Painter to copy the effects from the banner to the text box. 

1. Click the object that has the effects you want to copy. In our example, 
we'll click our banner shape. 

 

2. From the Animations tab, click the Animation Painter command. 

 

3. Click the object you want to copy the effects to. The effects are 
applied to the object. In our example, the effects from the shape are 
applied to the text box. 



 

To reorder the animations: 

1. Select the number of the effect you want to change. 

 

2. From the Animations tab, click the Move Earlier or Move 
Later commands to change the ordering. 

 

To preview animations: 

Any animation effects you have applied will show up when you play the slide show. 

However, you can also quickly preview the animations for the current slide without 

viewing the slide show. 



1. Navigate to the slide you want to preview. 

2. From the Animations tab, click the Preview command. The 
animations for the current slide will play. 

 

The Animation Pane 

The Animation Pane allows you to view and manage all of the effects that are on 

the current slide. You can modify and reorder effects directly from the Animation 

Pane, which is especially useful when you have several effects. 

To open the Animation Pane: 

1. From the Animations tab, click the Animation Pane command. 

 

2. The Animation Pane will open on the right side of the window. It will 
show all of the effects for the current slide in the order in which they 
will appear. 



 

If you have several animated objects, it may help to rename the objects before 

reordering them in the Animation Pane. You can rename them in the Selection 

Pane. To open the Selection Pane, click an object, then from the Format tab 

click Selection Pane. Double-click the name of an object to rename it. 

 

To reorder effects from the Animation Pane: 

1. On the Animation Pane, click and drag an effect up or down. 



 

2. The effects will reorder themselves. 

To preview effects from the Animation Pane: 

1. From the Animation Pane, click the Play button. 

 

2. The effects for the current slide will play. On the right side of the 
Animation Pane, you will be able to see a timeline that shows the 
progress through each effect. 



 

If the timeline is not visible, click the drop-down arrow for an effect, then 

select Show Advanced Timeline. 

 

To change an effect's start option: 

By default, an effect starts playing when you click the mouse during a slide show. If 

you have multiple effects, you will need to click multiple times to start each effect 



individually. However, by changing the start option for each effect, you can have 

effects that automatically play at the same time or one after the other. 

1. From the Animation Pane, select an effect. A drop-down arrow will 
appear next to the effect. 

 

2. Click the drop-down arrow. You will see three start options: 

o Start on Click: This will start the effect when the mouse is 
clicked. 

o Start With Previous: This will start the effect at the same time 
as the previous effect. 

o Start After Previous: This will start the effect when the 
previous effect ends. 



 
3. Select the desired start option. 

When you preview the animations, all of the effects will play through 

automatically. To test effects that are set to Start on Click, you will need to play 

the slide show. 

The Effect Options dialog box 

From the Animation Pane, you can access the Effect Options dialog box, which 

contains more advanced options you can use to fine tune your animations. 

To open the Effect Options dialog box: 

1. From the Animation Pane, select an effect. A drop-down arrow will 
appear next to the effect. 

2. Click the drop-down arrow, then select Effect Options. 



 

3. The Effect Options dialog box will appear. From here, you can add 
various enhancements to the effect: 

o Sound: Adds a sound effect to the animation 

o After animation: Changes the color or hides the object after 
the animation is over 

o Animate text: Allows you to animate text all at once, one 
word at a time, or one letter at a time 



 

SLIDE SHOW TAB 

This tab provides options for presenting the Slide Show to the audience. Narration 

for the show can be recorded. Decisions can be made as to where to start the 

presentation. In addition, custom shows can be created. The table below provides 

a listing of the groups and buttons available on the ribbon for this tab. A 

description of each of the buttons is also provided.  

Start Slide Show Group  

From Beginning Click this button to start the slide show at the first slide. This will 

start the show at the beginning even though the insertion point is not in the first 

slide.  

From Current Slide When the insertion point is in a different slide than the first 

one, clicking this button will start the show on the selected slide.  

Present Online This option is used to present a PowerPoint presentation on the 

Internet using the default presentation service. The viewers can watch the 

presentation through a Web browser.  



Custom Slide Show A custom slide show displays only selected slides. This option 

makes it possible to have several slide shows within the same presentation.  

Set Up Group  

Set Up Slide Show This button is used to set up advanced options for a 

presentation such as viewing the show on a kiosk.  

Hide Slide To hide a slide within the presentation, click this button. This means that 

the slide will not be shown during the presentation. However, it will still display in 

Normal view. This is a toggle button that when clicked the first time will hide the 

slide. When it is clicked the second time, it will display the slide.  

Rehearse Timings This option is used to rehearse the timing for a presentation. 

These timings can be used when a presentation is a self-running show, such as 

when displaying it on a kiosk.  

Record Slide Show To record a narration to go with the slides in the presentation, 

click this button. The Record Narration dialog box will display where the options for 

recording can be set.  

Play Narrations This option allows narrations and laser gestures to be played back 

during a slide show.  

Use Timings Click the check box for this option if the timings that were set up will 

be used during the presentation.  

Show Media Controls Select this option to have media controls for audio and video 

show when the mouse pointer is moved over an object during a slide show 

presentation.  

Monitors Group  

Show Presentation On Click the arrow for this option to choose whether to let 

PowerPoint chose the monitor to show the presentation on or to allow the 

presenter to select the monitor. This option is only available when more than one 

monitor is connected to the computer.  

Use Presenter View This option is used when a computer is connected to more 

than one monitor. One monitor can be used to show the slide show while the other 



screen can be used to show speaker notes for the presenter. If the computer only 

has one monitor Alt+F5 can be used to display the slide show in Presenter View 

Review tab 

Before presenting your PowerPoint, you might decide to ask someone else to look 

over it. The two of you might even collaborate on a presentation. If you were 

revising a hard copy of a report, you might add comments in the margins 

or compare your rough and final drafts side by side. You can also do these things in 

PowerPoint using the Comments and Compare features 

 

. 

Commenting on presentations 

When you are revising or collaborating on a presentation, you might want to make 

notes or suggestions without actually changing anything on the slide. 

Using comments allows you to take note of anything on a slide without altering the 

slide itself. Comments can be added and read by the original author or any other 

reviewers. 

To add a comment: 

1. Select the text or click on the area of the slide where you want the 
comment to appear. 

2. Select the Review tab, then locate the Comments group. 

3. Click the New Comment command. 

 



4. The Comments pane will appear on the right side of the window. Type 
your comment. 

 

5. Press Enter or click anywhere on the slide to return to your 
presentation. 

Added comments show up as small thumbnails rather than full-sized notes. To 

read a comment, click the thumbnail to open the Comments pane. 

 

To edit a comment: 

1. Select the comment you want to edit by clicking the comment 
thumbnail. 



 

2. The Comments pane will appear. Click the comment to edit it. 

 

3. Make the desired changes. 

 

4. Press Enter or click anywhere on the slide, and the comment will 
update to reflect your edits. 



 

To respond to a comment: 

1. Click the thumbnail of the comment you want to edit. 
The Comments pane will appear. 

2. The selected comment will be highlighted. Click Reply... 

 

3. Type your comment. 



 

4. Press Enter or click anywhere on the slide. The new comment will 
appear below the original comment, and a new thumbnail will appear 
on the slide. 

 

To delete a comment: 

1. Select the comment you want to delete. 

2. From the Review tab, click the Delete command. 

 



To delete multiple comments, click the Delete drop-down arrow and select Delete 

All Comments and Ink on This Slide or Delete All Comments and Ink in This 

Presentation. 

 

Comparing presentations 

If you are collaborating on a presentation or asking someone else to review your 

presentation, you might want to use the Compare feature. The Compare feature 

combines two versions of the same presentation. This allows you to see the 

differences between the two and decide which changes to include in the final 

version of your presentation. 

 

To compare two presentations: 

Before you start, you'll need to have one version of the presentation open. When 

you're ready to compare, you'll select the second version. 

1. Select the Review tab, then locate the Compare group. 

2. Click Compare. 

 



3. A dialog box will appear. Browse for and select the desired file. 

 

4. Click Open. 

5. The Revisions pane will appear, allowing you to compare the two 
presentations. 

View Tab 
When working with PowerPoint, this tab is used to view the presentation 
in different formats, it is also used to view more than one PowerPoint 
window at a time, or to decide whether to display the ruler within the 
window. This document lists each of the groups and buttons on the 
ribbon for this tab. A description of each of the buttons on the ribbon is 
also provided.  

Presentation Views Group  

Normal This is the default view for all PowerPoint presentations. In this 
view, the slide pane and thumbnails of the slides will be displayed.  

Outline View Click this button to view the presentation as an outline. 
The outline will appear in the frame to the left of the slide pane. It will 
replace the slides pane.  



Slide Sorter To view the slides as thumbnails, click this button. The slides 
will appear in columns and rows. This format makes it easy to rearrange 
the slides.  

Notes Page When this view is chosen, the slides appear at the top of the 
page and the speaker notes that have been entered for the presentation 
will show at the bottom of the page.  

Reading View This view is used to view the presentation as a slide show 
that fits within the window.  

Master Views Group  

Slide Master Click this button to change the design and layout of the 
slide masters. These masters are the ones that each slide in the 
presentation is based on. The changes affect what is displayed on all the 
slides with that layout in the presentation. Animations and transitions 
can be added in the slide master. The top, larger slide is used to change 
options for all the slides in the presentation no matter what the layout.  

Handout Master To change the design and layout of the printed 
handouts for a presentation, click this button.  

Notes Master This button is used to change the way the notes page is 
displayed and printed.  

Show Group  

Ruler To display the horizontal and vertical ruler in the PowerPoint 
window a check mark must appear in the check box for this option.  

Gridlines Click the check box for this option to display gridlines in a 
presentation. The gridlines are used to align objects on a slide.  

Guides Use this option to show adjustable drawing guides to which 
objects can be aligned on the slide.  

Notes Click this button to add speaker notes to a presentation. These 
notes can be used for quick reference during a presentation.  

Zoom Group  

Zoom To specify the zoom level for viewing the slide in the PowerPoint 
window, click this button. The Zoom dialog box will display where zoom 
levels may be specified.  



Fit to Window This button is used to zoom the presentation so that the 
slide fills the window.  

Color/Grayscale Group  

Color To view the presentation in color, choose this option. This is the 
default option for viewing presentations.  

Grayscale This button is used to view the presentation in grayscale. Gray-
scale shows the presentation in black and white with gray tones.  

Black and White When this option is chosen, the presentation will be 
shown in black and white without any gray tones.  

Window Group  

New Window To open a new PowerPoint window, click this button. A 
new window will open with the same presentation. The presentation will 
have a number after the name.  

Arrange All Click this button to tile the open windows on the screen side-
by-side.  

Cascade Use this button to tile the open windows so that they overlap 
vertically on the screen.  

Move Split This option is used to move the splitters that separate the 
different sections of the window.  

Switch Windows Click this button to switch from one window to another 
window. A list of the open windows will display when the button is 
clicked.  

Macros Group  

Macros These are miniature programs that are used to perform specified 
tasks within a program. Examples of Macros are Ctrl + P for print or Ctrl + 
S for save. When this button is clicked, a list of macros will be displayed. 

 
 

 



INTERNET 
Introduction 

The Internet is an increasingly important part of everyday life for people around 

the world. But if you've never used the Internet before, all of this new information 

might feel a bit confusing at first. 

Throughout this tutorial, we'll try to answer some basic questions you may have 

about the Internet and how it's used. When you're done, you'll have a good 

understanding of how the Internet works, how to connect to the Internet, 

and how to browse the Web. 

What is the Internet? 

The Internet is a global network of billions of computers and other electronic 

devices. With the Internet, it's possible to access almost any information, 

communicate with anyone else in the world, and do much more. 

You can do all of this by connecting a computer to the Internet, which is also 

called going online. When someone says a computer is online, it's just another way 

of saying it's connected to the Internet. 

 

What is the Web? 

The World Wide Web—usually called the Web for short—is a collection of 

different websites you can access through the Internet. A website is made up of 

related text, images, and other resources. Websites can resemble other forms of 



media—like newspaper articles or television programs—or they can be interactive 

in a way that's unique to computers. 

The purpose of a website can be almost anything: a news platform, an 

advertisement, an online library, a forum for sharing images, or an educational site 

like us! 

 

Once you are connected to the Internet, you can access and view websites using a 

type of application called a web browser. Just keep in mind that the web browser 

itself is not the Internet; it only displays websites that are stored on the Internet. 

How does the Internet work? 

At this point you may be wondering, how does the Internet work? The exact 

answer is pretty complicated and would take a while to explain. Instead, let's look 

at some of the most important things you should know. 

It's important to realize that the Internet is a global network of physical cables, 

which can include copper telephone wires, TV cables, and fiber optic cables. Even 

wireless connections like Wi-Fi and 3G/4G rely on these physical cables to access 

the Internet. 

When you visit a website, your computer sends a request over these wires to 

a server. A server is where websites are stored, and it works a lot like your 

computer's hard drive. Once the request arrives, the server retrieves the website 



and sends the correct data back to your computer. What's amazing is that this all 

happens in just a few seconds! 

Watch the video below from Tata Communications to learn more about how the 

Internet functions. 

Other things you can do on the Internet 

One of the best features of the Internet is the ability to communicate almost 

instantly with anyone in the world. Email is one of the oldest and most universal 

ways to communicate and share information on the Internet, and billions of people 

use it. Social media allows people to connect in a variety of ways and build 

communities online. 

 

There are many other things you can do on the Internet. There are thousands of 

ways to keep up with news or shop for anything online. You can pay your 

bills, manage your bank accounts, meet new people, watch TV, or learn new skills. 

You can learn or do almost anything online. 

Finding information online 

With billions of websites online today, there is a lot of information on the 

Internet. Search engines make this information easier to find. All you have to do is 

type one or more keywords, and the search engine will look for relevant websites. 

For example, let's say you're looking for a new pair of shoes. You could use a 

search engine to learn about different types of shoes, get directions to a nearby 

shoe store, or even find out where to buy them online! 



 

There are many different search engines you can use, but some of the most 

popular include Google, Yahoo!, and Bing. 

Email 

Short for electronic mail, email is a way to send and receive messages across the 

Internet. Almost everyone who uses the Internet has their own email account, 

usually called an email address. This is because you'll need an email address to do 

just about anything online, from online banking to creating a Facebook account. 



 

Social networking 

Social networking websites are another way to connect and share with your 

family and friends online. Rather than sharing with just a few people over email, 

social networks make it easier to connect and share with many people at the same 

time. Facebook is the world's largest social networking site, with more than 1 

billion users worldwide. 
 

Chat and instant messaging 

Chat and instant messaging (IM) are short messages sent and read in real time, 

allowing you to converse more quickly and easily than email. These are generally 

used when both (or all) people are online, so your message can be read 

immediately. By comparison, emails won't be seen until recipients check their 

inboxes. 



 

Examples of instant messaging applications include Yahoo Messenger and Google 

Hangouts. Some sites, like Gmail and Facebook, even allow you to chat within your 

web browser. 

Online media 

There are many sites that allow you to watch videos and listen to music. For 

example, you can watch millions of videos on YouTube or listen to Internet radio 

on Pandora. Other services, like Netflix and Hulu, allow you to watch movies and 

TV shows. And if have a set-top streaming box, you can even watch them directly 

on your television instead of a computer screen. 

 

Everyday tasks 

You can also use the Internet to complete many everyday tasks and errands. For 

example, you can manage your bank account, pay your bills, and shop for just 

about anything. The main advantage here is convenience. Rather than going from 

place to place, you can do all of these tasks at home! 



 

And a whole lot more! 

Remember, these are just a few of the things you'll be able to do online. Keep 

working through this tutorial to learn more about connecting to the Internet and 

using the Web! 

How do I connect to the Internet? 

Once you've set up your computer, you may want to purchase home Internet 

access so you can send and receive email, browse the Web, stream videos, and 

more. You may even want to set up a home wireless network, commonly known 

as Wi-Fi, so you can connect multiple devices to the Internet at the same time. 

Watch the video below to learn about connecting to the Internet. 

Types of Internet service 

The type of Internet service you choose will largely depend on which Internet 

service providers (ISPs) serve your area, along with the types of service they offer. 

Here are some common types of Internet service. 

 Dial-up: This is generally the slowest type of Internet connection, and 
you should probably avoid it unless it is the only service available in 
your area. Dial-up Internet uses your phone line, so unless you have 
multiple phone lines you will not be able to use your landline and the 
Internet at the same time. 



 DSL: DSL service uses a broadband connection, which makes it much 
faster than dial-up. DSL connects to the Internet via a phone line but 
does not require you to have a landline at home. And unlike dial-up, 
you'll be able to use the Internet and your phone line at the same 
time. 

 Cable: Cable service connects to the Internet via cable TV, although 
you do not necessarily need to have cable TV in order to get it. It uses 
a broadband connection and can be faster than both dial-up and DSL 
service; however, it is only available where cable TV is available. 

 Satellite: A satellite connection uses broadband but does not require 
cable or phone lines; it connects to the Internet through satellites 
orbiting the Earth. As a result, it can be used almost anywhere in the 
world, but the connection may be affected by weather patterns. 
Satellite connections are also usually slower than DSL or cable. 

 3G and 4G: 3G and 4G service is most commonly used with mobile 
phones, and it connects wirelessly through your ISP's network. 
However, these types of connections aren't always as fast as DSL or 
cable. They will also limit the amount of data you can use each 
month, which isn't the case with most broadband plans. 

Choosing an Internet service provider 

Now that you know about the different types of Internet service, you can do some 

research to find out what ISPs are available in your area. If you're having trouble 

getting started, we recommend talking to friends, family members, and neighbours 

about the ISPs they use. This will usually give you a good idea of the types of 

Internet service available in your area. 

Most ISPs offer several tiers of service with different Internet speeds, usually 

measured in Mbps (short for megabits per second). If you mainly want to use the 

Internet for email and social networking, a slower connection (around 2 to 5 

Mbps) might be all you need. However, if you want to download music or stream 

videos, you'll want a faster connection (at least 5 Mbps or higher). 

You'll also want to consider the cost of the service, including installation charges 

and monthly fees. Generally speaking, the faster the connection, the more 

expensive it will be per month. 



Although dial-up has traditionally been the least expensive option, many ISPs have 

raised dial-up prices to be the same as broadband. This is intended to encourage 

people to switch to broadband. We do not recommend dial-up Internet unless it's 

your only option. 

Hardware needed 

Modem 

 

Once you have your computer, you really don't need much additional hardware to 

connect to the Internet. The primary piece of hardware you need is a modem. 

The type of Internet access you choose will determine the type of modem you 

need. Dial-up access uses a telephone modem, DSL service uses a DSL 

modem, cable access uses a cable modem, and satellite service uses a satellite 

adapter. Your ISP may give you a modem—often for a fee—when you sign a 

contract, which helps ensure that you have the right type of modem. However, if 

you would prefer to shop for a better or less expensive modem, you can choose to 

buy one separately. 

Router 



 

A router is a hardware device that allows you to connect several 

computers and other devices to a single Internet connection, which is known as 

a home network. Many routers are wireless, which allows you to create a home 

wireless network, commonly known as a Wi-Fi network. 

You don't necessarily need to buy a router to connect to the Internet. It's possible 

to connect your computer directly to your modem using an Ethernet cable. Also, 

many modems include a built-in router, so you have the option of creating a Wi-Fi 

network without buying extra hardware. 

Setting up your Internet connection 

 



Once you've chosen an ISP, most providers will send a technician to your house to 

turn on the connection. If not, you should be able to use the instructions provided 

by your ISP—or included with the modem—to set up your Internet connection. 

After you have everything set up, you can open your web browser and begin using 

the Internet. If you have any problems with your Internet connection, you can call 

your ISP's technical support number. 

Home networking 

 

If you have multiple computers at home and want to use all of them to access the 

Internet, you may want to create a home network, also known as a Wi-Fi network. 

In a home network, all of your devices connect to your router, which is connected 

to the modem. This means everyone in your family can use the Internet at the 

same time. 

Your ISP technician may be able to set up a home Wi-Fi network when installing 

your Internet service. If not, you can review our lesson on How to Set Up a Wi-Fi 

Network to learn more. 

If you want to connect a computer that does not have built-in Wi-Fi connectivity, 

you can purchase a Wi-Fi adapter that plugs into your computer's USB port. 



What is the cloud? 

You may have heard people using terms like the cloud, cloud computing, or cloud 

storage. But what exactly is the cloud? 

Simply put, the cloud is the Internet—more specifically, it's all of the things you 

can access remotely over the Internet. When something is in the cloud, it means 

it's stored on Internet servers instead of your computer's hard drive. 

Watch the video below to learn more about the cloud. 

Why use the cloud? 

Some of the main reasons to use the cloud are convenience and reliability. For 

example, if you've ever used a web-based email service, such as Gmail or Yahoo! 

Mail, you've already used the cloud. All of the emails in a web-based service are 

stored on servers rather than on your computer's hard drive. This means you can 

access your email from any computer with an Internet connection. It also means 

you'll be able to recover your emails if something happens to your computer. 

 

Let's look at some of the most common reasons to use the cloud. 

 File storage: You can store all types of information in the cloud, 
including files and email. This means you can access these things 
from any computer or mobile device with an Internet connection, not 



just your home computer. Dropbox and Google Drive are some of the 
most popular cloud-based storage services. 

 

 File sharing: The cloud makes it easy to share files with several people 
at the same time. For example, you could upload several photos to a 
cloud-based photo service like Flickr or iCloud Photos, then quickly 
share them with friends and family. 

 

 Backing up data: You can also use the cloud to protect your files. 
There are apps such as Carbonite that automatically back up your 
data to the cloud. This way, if your computer ever is lost, stolen, or 
damaged, you'll still be able to recover these files from the cloud. 



 

What is a web app? 

Previously, we talked about how desktop applications allow you to perform tasks 

on your computer. But there are also web applications—or web apps—that run in 

the cloud and do not need to be installed on your computer. Many of the most 

popular sites on the Internet are actually web apps. You may have even used a web 

app without realizing it! Let's take a look at some popular web apps. 

 Facebook: Facebook lets you create an online profile and interact 
with your friends. Profiles and conversations can be updated at any 
time, so Facebook uses web app technologies to keep the 
information up to date. 

 



 Pixlr: Pixlr is an image editing application that runs in your web 
browser. Much like Adobe Photoshop, it includes many advanced 
features, like color correction and sharpening tools. 

 

 Google Docs: Google Docs is an office suite that runs in your browser. 
Much like Microsoft Office, you can use it to 
create documents, spreadsheets, presentations, and more. And 
because the files are stored in the cloud, it's easy to share them with 
others. 

 

Using a web browser 

A web browser is a type of software that allows you to find and view websites on 

the Internet. Even if you didn't know it, you're using a web browser right now to 

read this page! There are many different web browsers, but some of the most 



common ones include Google Chrome, Internet Explorer, Safari, Microsoft Edge, 

and Mozilla Firefox. 

No matter which web browser you use, you'll want to learn the basics of browsing 

the Web. In this lesson, we'll talk about navigating to different websites, using 

tabbed browsing, creating bookmarks, and more. 

Watch the video below to learn the basics of using a web browser. 

We'll be using the Google Chrome web browser throughout this lesson, but you 

can use any browser you want. Keep in mind that your browser may look and act a 

bit differently, but all web browsers work in basically the same way. 

URLs and the address bar 

Each website has a unique address, called a URL (short for Uniform Resource 

Locator). It's like a street address that tells your browser where to go on the 

Internet. When you type a URL into the browser's address bar and press Enter on 

your keyboard, the browser will load the page associated with that URL. 

In the example below, we've typed www.bbc.com/travel into the address bar. 

 

Links 

Whenever you see a word or phrase on a website that's blue or underlined in blue, 

it's probably a hyperlink, or link for short. You might already know how links work, 

even if you've never thought about them much before. For example, try clicking 

the link below. 

Hey, I'm a link! Click me! 

Links are used to navigate the Web. When you click a link, it will usually take you 

to a different webpage. You may also notice that your cursor changes into a hand 

icon whenever you hover over a link. 



 

If you see this icon, it means you've found a link. You'll find other types of links this 

way too. For example, many websites actually use images as links, so you can 

just click the image to navigate to another page. 

Review our lesson on Understanding Hyperlinks to learn more. 

Navigation buttons 

The Back and Forward buttons allow you to move through websites 

you've recently viewed. You can also click and hold either button to see your 

recent history. 

 

The Refresh button will reload the current page. If a website stops working, try 

using the Refresh button. 

 

Tabbed browsing 

Many browsers allow you to open links in a new tab. You can open as many links as 

you want, and they'll stay in the same browser window instead of cluttering your 

screen with multiple windows. 



To open a link in a new tab, right-click the link and select Open link in new tab (the 

exact wording may vary from browser to browser). 

 

To close a tab, click the X. 

 

To create a new blank tab, click the button to the right of any open tabs. 

 

Bookmarks and history 

If you find a website you want to view later, it can be hard to memorize the exact 

web address. Bookmarks, also known as favorites, are a great way to save and 

organize specific websites so you can revisit them again and again. Simply locate 

and select the Star icon to bookmark the current website. 



 

Your browser will also keep a history of every site you visit. This is another good 

way to find a site you visited previously. To view your history, open your browser 

settings—usually by clicking the icon in the upper-right corner—and select History. 

 

 



 

Downloading files 

Links don't always go to another website. In some cases, they point to a file that 

can be downloaded, or saved, to your computer. 

If you click a link to a file, it may download automatically, but sometimes it 

just opens within your browser instead of downloading. To prevent it from 

opening in the browser, you can right-click the link and select Save link 

as (different browsers may use slightly different wording, like Save target as). 

 

Review our lesson on Downloading and Uploading to learn more. 

Saving images 

Sometimes you may want to save an image from a website to your computer. To 

do this, right-click the image and select Save image as (or Save picture as). 



 

Plug-ins 

Plug-ins are small applications that allow you to view certain types of content 

within your web browser. For example, Adobe Flash and Microsoft Silverlight are 

sometimes used to play videos, while Adobe Reader is used to view PDF files. 

If you don't have the correct plug-in for a website, your browser will usually 

provide a link to download it. There may also be times when you need 

to update your plug-ins. Review our lesson on Installing and Updating Plug-ins to 

learn more. 

 

Understanding hyperlinks 

Have you ever noticed that certain words on the Web look a little bit different? 

Whenever you see a word or phrase that's underlined in blue, it's probably 

a hyperlink, or link for short. You might already know how links work, even if 



you've never thought about them much before. For example, try clicking the link 

below. 

Hey, I'm a link! Click me! 

Links are used to navigate the Web. When you click a link, it will take you to a 

different webpage. In the example below, we're clicking a link to learn more about 

the Cape Hatteras National Seashore. 

 

When you hover over a Wikipedia link, a preview of the linked site appears to give 

you more information. It is important to note that most web browsers show the 

link's URL in the bottom-left corner of the window. 



 

You may also notice that your cursor changes into a hand icon whenever you hover 

over a link. 

 

If you see this icon, it means you've found a link. You'll find other types of links this 

way too. For example, many websites actually use images as links, so you can 

just click the image to navigate to another page. In the example below, we're 

clicking the picture of a coffee mug to open a page with more information about it. 



 

Links don't always go to another website. In some cases, they allow you 

to download a file. When you click a link like this, the file will be downloaded to 

your computer. In the example below, we're downloading an installation file for a 

new application. 

 

As you can see, links are an important part of using the Web. They allow you to 

navigate between different webpages, download files, and do a whole lot more. 



Downloading and uploading 

 

While exploring the Internet, you’ve probably encountered the 

terms downloading and uploading. Downloading means receiving data or a file 

from the Internet on your computer. Uploading means sending data or a file from 

your computer to somewhere on the Internet. 

These terms describe activities you may have already learned how to do. If you've 

ever opened an example document in one of our tutorials, you've downloaded that 

file. If you’ve ever shared a photo you took on Facebook or another social media 

site, you've uploaded that photo. 

Downloading 

Usually, when you download a file you will start the download by clicking a link to 

that file. Many of our tutorials contain links to files, like this: 

Download our practice document. 

If you click the link, your browser should prompt you to select one of two methods 

for downloading the file. 

 Open with will download the file and load it immediately in the 
specified program. 

 Save File will download it and save it to your hard drive. 



 

Either way, once you click OK, the download begins. Your browser will indicate the 

progress and time remaining on the download. 

 

Once the download is complete, either the file will be saved to your computer or it 

will open in the program you selected. If you have trouble finding the file after 

you’ve downloaded it, check out our Finding Your Downloads lesson. 

Some browsers don’t always start this download process when you click the link to 

a file. In these cases, you can right-click the link, then click Save Link As, then select 

a location to download the file. 

Uploading 

If a site allows uploads, it will have an upload utility to help perform the file 

transfer. Each site handles this process differently, but we’ll give some common 

examples. Usually, the site will have help pages to walk you through the upload 

process. 

Many sites have an upload button that opens a dialog box. For example, Facebook 

has a camera icon that begins the upload process. 

 



A dialog box will appear, prompting you to select a file. Browse to the location 

where your file is stored, select it, then click the Open button. Afterward, a 

progress bar tracking the upload process will appear on the page. 

 

Some sites support a drag-and-drop interface. For example, when logged in to 

Dropbox you can drag the files from a folder on your computer and drop them into 

the browser window. 

 

Many other upload utilities have similar features. A more detailed example of 

uploading a file is available in our Google Drive tutorial. 

 



Using search engines 

With billions of websites online today, there is a lot of information on the 

Internet. Search engines make this information easier to find. Let's look at the 

basics of using a search engine, as well as some techniques you can use to 

get better search results. 

Watch the video below to learn more about searching the Web. 

How to search the Web 

There are many different search engines you can use, but some of the most 

popular include Google, Yahoo!, and Bing. To perform a search, you'll need to 

navigate to a search engine in your web browser, type one or more keywords—

also known as search terms—then press Enter on your keyboard. In this example, 

we'll search for recipes. 

 

After you run a search, you'll see a list of relevant websites that match your search 

terms. These are commonly known as search results. If you see a site that looks 

interesting, you can click a link to open it. If the site doesn't have what you need, 

you can simply return to the results page to look for more options. 



 

Most browsers also allow you to perform a web search directly from your address 

bar, although some have a separate search bar next to the address bar. Simply 

type your search terms and press Enter to run the search. 

 

Search suggestions 

If you don't find what you're looking for on the first try, don't worry! Search 

engines are good at finding things online, but they're not perfect. You'll often need 

to try different search terms to find what you're looking for. 

If you're having trouble thinking of new search terms, you can use search 

suggestions instead. These will usually appear as you're typing, and they're a great 

way to find new keywords you might not have tried otherwise. To use a search 

suggestion, you can click it with your mouse, or select it with the arrow keys on 

your keyboard. 



 

Refining your search 

If you're still having trouble finding exactly what you need, you can use some 

special characters to help refine your search. For example, if you want to exclude a 

word from a search, you can type a hyphen (-) at the beginning of a word. So if you 

wanted to find cookie recipes that don't include chocolate, you could search 

for recipes cookies -chocolate. 

 

You can also search for exact words or phrases to narrow down your results even 

more. All you need to do is place quotation marks (" ") around the desired search 

terms. For example, if you search for recipes "sugar cookies", your search results 

will only include recipes for sugar cookies, instead of any cookies that happen to 

use sugar as an ingredient. 



 

These techniques may come in handy in certain cases, but you probably won't 

need to use them with most searches. Search engines can usually figure out what 

you're looking for without these extra characters. We recommend trying a few 

different search suggestions before using this method. 

Content-specific searches 

There may be times when you're looking for something more specific, like a news 

article, picture, or video. Most search engines have links at the top of the page 

that allow you to perform these unique searches. 

 



In the example below, we've used the same search terms to look 

for images instead of websites. If you see an image you like, you can click to visit 

the website it originally came from. 

 

You can use the extra search tools to narrow down your results even more. These 

tools will change based on the type of content you're looking for, but in this 

example we can filter our images by size, color, image type, and more. So if you 

wanted to find cookies with pink frosting, you could search for images that are 

mostly pink. 

 

Advertisements 



One final thing to note: Most search engines include advertisements with search 

results. For example, you can see advertisements at the top of the search results 

below. 

 

These ads are based on your search terms, and they often look similar to other 

search results. While they may be useful in some cases, it's usually more helpful to 

focus on the actual search results. 

For even more search tips, check out our Search Better tutorial. 

 

Understanding URLs 

Every time you click a link on a website or type a web address into your browser, 

it’s a URL. URL stands for Uniform Resource Locator. Think of it like a street 

address, with each portion of the URL as different parts of the address, and each 

giving you different information. Let’s examine each component of a URL and what 

we can learn from it. 

Watch the video below to learn the different parts of a URL. 

Scheme 



Every URL begins with the scheme. This tells your browser what type of address it 

is so the browser connects to it correctly. There are many types of schemes, but for 

typical web browsing you will mostly see http and https. Your browser usually 

won’t show the scheme in the address bar, and usually you don’t need to type the 

scheme when typing a web address; instead, you can just begin with the domain 

name. The scheme is still always part of the URL; it just isn’t being displayed. 

 

Domain name 

The domain name is the most prominent part of a web address. Typically, different 

pages on the same site will continue to use the same domain name. For example, 

all pages on this site share the GCFLearnFree.org domain name. 

 

Each segment of the domain name separated by a period is called a domain. The 

domain on the right is called a top-level domain, with the domain to the left of it 

called the second-level domain, then third-level domain, and so on. 

 

You can often learn something about the site from the domains. One of the 

domains usually identifies the organization, while the top-level domain may give 

you more general information on what kind of site it is. For example, in the domain 



name nc.gov, the .gov domain means it is a government website in the United 

States, the nc domain identifies it as the website of North Carolina. 

In most URLs, the www domain can be 

omitted. Google.com and www.google.com lead to the same page. However, 

other subdomains cannot be omitted. For example, all pages 

under news.google.com require the news subdomain in the URL. 

File path 

The file path—often just called the path—tells your browser to load a specific 

page. If you don’t specify a path and only enter a domain name, your browser is 

still loading a specific page; it’s just loading a default page, which usually will help 

you navigate to other pages. 

 

URLs that end with the domain name without a file path usually will load a 

homepage or an index page that's designed to help you navigate to specific pages 

on the site. Often, if you can’t remember the file path for a specific page, you can 

go to the homepage and search for it. 

Parameters 

Some URLs include a string of characters after the path—beginning with a question 

mark—called the parameter string. You have probably noticed this part of 

a URL appear in your address bar after performing a search on Google or YouTube. 

The parameter string can be clear or confusing to a human user, but it is critical 

information for the server. 



 

Anchor 

Also appearing after the path, the anchor tells your browser to scroll to or load a 

specific part of the page. Usually the anchor begins with a hashtag and is used to 

direct your browser to a specific part of a very long page, much like a bookmark. 

Different anchors don’t load different pages; they simply tell the browser to display 

different parts of the page. 

 

A whole URL 

When combined, these elements make up a URL, although not all URLs will have all 

five parts. 

 

Using what we learned in this tutorial, we can tell from the domain name of this 

URL that it’s on Wikipedia, from the parameters that the page is probably about 

burritos, and from the anchor that we’ll be looking at the section on burritos for 

breakfast. 



Keep in mind that these are the most common components of a URL. There are 

many other parts, but these are the five you will see most often and that can 

usually give you the most information. 

How to set up a Wi-Fi network 

 

The Internet is a really powerful tool. It gives us access to all kinds of information at 

a moment's notice—think email, Google search, and Wikipedia. So there's 

something a little counterintuitive about only being able to use the Internet when 

you sit down at a desktop computer. What if you could use the Internet from 

anywhere in your home or office? 

If you already have high-speed (broadband) Internet service at your house, it's 

pretty easy to create your own home wireless network. Commonly known as Wi-

Fi, a wireless network allows you to connect laptops, smartphones, and other 

mobile devices to your home Internet service without an Ethernet cable. 

Purchase a wireless router 



 

To create your own Wi-Fi network, you'll need a wireless router. This is the device 

that will broadcast the Wi-Fi signal from your Internet modem throughout your 

house. Your Internet service provider (ISP) may offer you a wireless router for a 

small monthly fee. If you've never set up a Wi-Fi network before, this may be the 

easiest option. 

If you want to buy your own router, we'd recommend spending a little more time 

researching different options. CNET offers a comprehensive guide on How to Buy a 

Router. 

Some Internet modems may already have a built-in wireless router, which means 

you won't need to purchase a separate one. 

Connect the cables 

 

1. Once you've acquired a wireless router, you'll need to connect it to 

your existing Internet modem. 



2. Connect an Ethernet cable from your modem to the wireless router 

(there is usually a short Ethernet cable included with your wireless 

router for this purpose). 

3. Plug in the power cable for the wireless router. 

4. Wait at least 30 to 60 seconds, and make sure the lights on your 

router are working correctly. 

Configure your router 

Next, you'll need to use your computer to configure your router's default settings. 

This includes setting a unique name and password for your wireless network. 

1. Using your web browser, enter the router's default IP address into 

the address bar, then press Enter. Your router's instructions should 

include this information, but some of the most common addresses 

include 192.168.0.1, 192.168.1.1, and 192.168.2.1. 

2. The router's sign-in page will appear. Again, the exact sign-in details 

should be included with your router's instructions, but most routers 

use a standard user name and password combination, such 

as admin and password. 

3. Your router's settings page will appear. Locate and select the Network 

Name setting, then enter a unique network name. 

4. Locate and select the Network Password setting, and choose an 

Encryption option. There are several types of encryption you can use, 

but we recommend WPA2, which is generally considered to be the 

most secure. 

5. Enter your desired password. Make sure to use a strong password to 

help ensure no one else can access your network. 

6. Locate and select the Save button to save your settings. 

Connect! 



That's it! Now you're ready to connect to your Wi-Fi network and make sure it's 

working. The process for connecting to a Wi-Fi network will vary slightly depending 

on what type of computer or device you're using, but any system will require these 

basic steps. 

1. Locate your computer's network settings, and search for nearby Wi-Fi 

networks. 

2. Select your network, and enter your password. 

3. If the connection is successful, open your web browser and try 

navigating to a webpage like www.google.com. If the page loads, it 

means your Wi-Fi connection is working correctly. 

Congratulations! 

You've just set up your own home wireless network. Way to go! 

Choosing a web browser 

A web browser is a type of software that allows you to find and view websites on 

the Internet. Even if you didn't know it, you're using a web browser right now to 

read this page! 

For many years, especially in the early 2000s, there was one browser that almost 

everyone used: Microsoft's Internet Explorer. If you used the Internet at that time, 

you probably clicked an icon like this to access the Web: 

 

In the past, Internet Explorer was pre-installed on any PC you buy. Starting in the 

mid-2000s, other software companies introduced new browsers, including Mozilla 

Firefox and Google Chrome. At the time, these browsers allowed for more 

experimental features. Because of this, web developers began creating websites 

with browsers like Chrome and Firefox in mind, which meant they didn't always 

work as well in Internet Explorer. If you have a PC with Windows 10, you'll have 



Microsoft Edge as your web browser instead. Watch this video to learn more about 

browsing in Edge.  

It's always a good idea to keep at least two web browsers on your computer or 

mobile device. This way, if a website isn't working correctly you can try opening the 

page in a different web browser. More often than not, this trick can solve a lot of 

problems you might encounter online. 

Choosing a Web Browser 

Infogram 

Using a PC or Android? Try Google Chrome. 

Google Chrome is probably the best web browser right now for PCs. It's free to 

download, it's very fast, and it's secure. Chrome is also the default web browser for 

many Android devices. Watch this video to learn about browsing in Chrome.  

If you have a Google account, you can even sync your saved passwords and 

browsing history across multiple devices. And because it downloads updates 

automatically, you'll always be protected from current security threats and viruses 

online. If you want to learn more, review our Chrome tutorial. 

Using an iPhone, iPad, or Mac? Try Safari. 

Safari is the default web browser for Mac computers and iOS devices, including the 

iPhone and iPad. Aside from being fast and secure, Safari has a lot of unique 

features. For example, Reader view allows you to see a simplified version of a 

webpage that's optimized for reading. It's also easy to add articles you find to your 

Reading List so you can save them for later. Watch this video to learn more about 

browsing in Safari.  

Again, we recommend keeping at least two web browsers on your device. Chrome 

is a good secondary browser to use on a Mac, iPhone, or iPad. It's also important to 

note that you cannot use Internet Explorer on a Mac or iOS device. 

Other recommended web browsers 

Firefox: This free web browser from Mozilla works on Windows, Mac, and Android. 

It's built by an open-source community of developers, so it will usually support 

even the most experimental web features. Like Chrome, it will be updated 



automatically, so you'll be protected from viruses and other threats online. Next, 

watch this video about browsing in Firefox. 
 

If you want to learn more, review our Firefox tutorial. 

Opera: Originally released in 1994, the Opera web browser has been around much 

longer than Firefox and Chrome. You may find that some websites don't load 

perfectly on Opera, but it's still regarded as a fast and secure alternative to your 

default browser. It's also available for all major operating systems (Windows, Mac, 

Android, and iOS). 

 

 

 

 

 

 

 

 
 

 


